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UPGRADERS CRIB SHEET 

To tac!l!tate your transition from Telewriter-64 to Telewriter-
128, we !is':: here the new featu:es and changes to the progra.n:, 
w!th re!erre~ces to the new manual . 

l) MACROS --- chapter VII. 

2) OPTIONS MENU & OPTIONS FILE -- chapter VI. Provides control of 
display parameters : Background Color, Character color, 24, 25, or 
28 line display; Monochrome on/off 

3) VIEW !'!lINT (Print Preview) -- Chapter IV. section 2D, also chapt V 
last half of section 4J & section 4L 

4) Pl or E keys take you to the Editor from anywhere in the program. 
F2 takes you to the Main menu from anywhere in the program. 
SHIFT-F2 takes you to the Format menu from anywerhe. S!!!FT-Fl 
takes you to the Options menu from anywhere. From the Main menu, 
F2 takes you to the Print and Format menu. 

A. 3 status windows -- CTRL-I (Info) 
B. Both CTRL- and CLEA.It- keys can be used tor Edi tor commands. 
C. A true block move has been added to the Editor. The command 

tor this is CTRL-M. (Telewriter-64's CLEAR-M, no longer takes 
you to the Main Menu. The F2 function key now does that.) 

D. Visible carriage returns CTRL-: 
E. Case-sensitivity in the Find and Global replace commands 

Chapter VI, section 5 
!. !!~d & Global replace can now search tor ll!'A replace all 

Telewriter special characters esnbedded control codes, 
carets, begin and end markers, carriage returns. 

G. word.wrap occurs at the current value of Characters per Line 
(not only at the edge ot the screen a• in Telewriter-64) 

H. Set Chars/line from Editor -- CTRL-@ 
I. Overstrike Mode -- ~-o 
J. Instant On-line K!LP (CTRL-!f) 
X. Dual Speed cursor (arrow key held down alone , arrow key 

S!!I!?T~) 
~. Key Repeat, Settable repeat and delay rates, dual speed cursor 

& delete keys -- Ch.apter V!, section o (Options Menu ) 
~- Xey cl!ck -- C'!'RL-L 
N. On-screen fore ign, :=ath a.~d special eymbols corresponding to 

~rinter control codes (Redesign Control character sub-c.enu in 
Opt!or.s menu - Chapter V!) 

0. Ct.£A.l{-V (page f!nder co=a.~d) e!!J::!nat_.j 
?. c~~-s & C!.E.AR-U (the speed ~I• com=a.~ds) have 'bee.~ 

e!!::.!.'1ateC.. speee oode is :-.ow auto::iat •c. Yo\:. never !'.ave to 
~~.:.--~ a!:>out !t again (!f you ever d!~ t .. ~ore ~ . 

Q. e.~ Marke:-$ not de!eted after a pa.:~1•! ~r~t or part!a! save 
(so yo-.;. ca.~ do :DOre worlt o::. the ~ b \oclt w! t!:out the need to 
rese~ t.'le ~d l"'.arker I 

~ . Se tt!ng 8 Begin or ~d :mrker (~ 9, ~-El auto:::at!cally 
de~etes t..~t l"'.arlter if !t's c.:..rrent!y •U' 

• 

UPGRADE.~' S C!t!B SP"ET 

S. Word delete -- CTRL-Y 
T. Non breakable space now generated by ALT-SPACESA..~ 

5) !/O 

A. Faster more efficient DISK I/0 -- Chapter III 
B. Quick save to disk without leaving the editor ~ CTRL-Q 
C. All disk files are now exclusively in ASCII a conversion 

prog!'am is provided if you need to convert your old Telewrite~-
64 files to load into Telewriter-128. Or, simply use the 
Telewriter-64 ASCII option to convert your fi!es for 
Telewriter-128. 

D. Auto file backup -- (Chapter VI. Options Menu) 

6) PRINTING 

A. Print automatically advances to the end of the last page when 
done (a.~d prints page number it desired) -- a new embedded 
co=and suppresses this when desired ("BX - Chapter v, section 
4C) 

8. Multiple copy print (•Print), print formatted file to disk 
( •print) 

C. Epson commands maintained but no longer documented in the 
Telewriter-128 manual. 

' 7) EMBEDDED COMMANDS 

A. Embedded contra! code de!!.~ition lines can now include 18 
nw:ibers instead of 15 

B. Footers -- Chapter V, sect!on 4G 
C. Add!tiona.l Header (& footer) Commands Chapter v, section 4F 
D. !!anging indents, new Margin controls - Chapter v, sect. 4p 
~- Flush right embedded command -- Chapter v, sect. 4N 
F. Addition new page commands - Chapter V, section 4C 
G. Any line beginning (or containing) a caret will not wordwrap 

and will not be aligned 
H. The backslash character (used for automatic page numbers 

within a header or footer) is generated by either ALT- / 
(ALT-slash) ot S!!!FT-@ (S!!IF! at sign). 

!. ability to specify the nu:nber of 2r!nt!.~q control codes in a 
de!!!lition l!r.e (Chapter V. section 4K) 

J. Justificetion ON/0~ cont:-o!lable w!t.'l e=beddeC. for:::at coc::and 
(. J•. - J-) 

8) ~eset key will generally put you right back !n Te!ewr!ter. 
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I. INTRODUCTION 

l THIS MANUAL 

Th1s tutorial is intended to get you writing with Telewriter-128 
almost 1auaed1ately. No knowledge of progr..aing or word 
processing is assumed, but you should be faailiar with the Tandy 
Color Computer 3 - especially with the use of DISK or CASSETTE for 
storing and retrieving information. 

This tutorial will guide you quickly through all the functio~ of 
Telewriter-128. In what follows, then, simply do exactly ~t the 
tutorial says. This will allow you to start using the syetem 
ilnlllediately, and quickly learn its basics. 

2 WORD PROCESSING AND TELDIRITER-128: AH OVERVIEW 

Simply stated, a word processor allows you to 1) WRITE and EDIT 
text, 2) FORMAT and PRINT it, and 3) SAVE it to disk or c-eette, 
and READ it IN at SOIDI! later time. 

These 3 distinct functions are mirrored in the structure of 
Telewriter and in the organization of this Tutorial. The &ditor 
is where you Write and Edit text. The Main Menu let'• you Save 
text to disk or cassette and Read it back in from there. The 
Print and ro~t Menu is where you prepare the text for 
Printing. 

Additionally, Telewriter's e9bedded cOllllands let you change 
foraatting and send printer controls, on the fly, from anywhere in 
the text. And the Optiona Menu lets you custoaize certain 
features of the program. 

3 DISPIJ.Y DEVICES 

The Color Computer 3 can be used with a number of different 
display devices (RGB Monitor, Monochrome Monitor, B6cW TV, Color 
TV). ~or this reason, Telewriter-128 provides a simple way for 
you to control many aspects of the screen display (screen color, 
character color. etc.), to suit both your particular hardware, and 
your personal preferences . :b 

EL.EWRITER-128 

For the purposes of this tutorial, 
Telewriter-128's sc~een display should 
device. tater you will learn how to 
exactly match your needs. 

I1" 

the starting values tor 
be adequate tor any display 
customize the display to 

Should there be a significant legibility problem, try adjusting 
your Monitor or TV. first. Try different settings of color, hue, 
brightness, and contrast. If the display is still not legible 
enough for you, read the first 5 sections of Chapter VI in this 
manual, which discuss using the Options Menu to customize the 
screen display. 

If you are using a saall TV, and the words are pushed too tar to 
the left. you will need to -itch to •O column mode (see Chapter 
I, section 25), or switch to a larger TV or to a Monochrome or RGB 
inonitor. First, though, see if your TV has a knob that IDOVes the 
image to the right. (Note that the examples below assu.e you are 
using the standard 80-column d.isplay - though almost all of them 
will work exactly the same in either mode. An inexpensive ($80) 
monochrome monitor is, however, the preferred display device tor 
word processing on this system. 

• RUNNING TELEHUTER-128: DISJC 

The first thing you should do is make a backup copy of t:he 
Telewriter-128 dislc, and put the original away for safe keeping. 
Use the BASIC "BACKUP" or "COPY" command as described in the Radio 
Shack Disk BASIC Manual. 

To run Telewriter-128, place the backup of your original 
Telewriter disk in drive 0, type LOAIM"TW128, and bit ENTER. The 
copyright notice will appear and the program will load. When it's 
done, the Main Menu will appear on the screen. 

5 RUNNING TELEWRITER-128: CASSETTE 

For your convenience, there is a complete copy of Telewriter-128 
on both sides of the tape. Start, now, with Side 1, and place the 
Telewriter tape in your recorder and rewind it. Reset the counter 
to 000 and press the PLAY button. Type CLOAD and hit ENTER. The 
program will be found (at about 010 on the counter) and loaded 
into memory. The top of the screen should say P TELE128 while the 
program is loading. 

When this is done and the screen says "OK", leave the Play button 
on, type RUN and hit ENTER. The copyright notice will appear, 
and the recorder will start again, reading in the bulk of 
Telewriter-128. Loading time is about 2 minutes. When the 
recorder stops, you will be looking at the Main Menu. 
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II. WRITING: THE EDITOR 

l ACC~SING THE EDITOR; END OF TEXT MARKER; THE CURSOR 

The Main Menu will be discussed in Chapter III. Right now, 
consider it, simply, as the gateway to the Telewriter Editor. 

A menu is 
letter. 
"Editor", 
gditor. 
writing. 

basically a list of 
The top command in 
so hit the E key 
The menu is gone 

commands, each invoked by its first 
the r 'ight column of the Main Menu is 

and you' 11 instantly be in the 
and you now have a blank screen for 

At the upper left of the screen you'll see a curved symbol § in 
reverse video. This marks the End of Text and it's at the very 
beginning of the page because you haven't typed any text in yet 
(the End and the Beginning are still the same). 

Now hit the ENTER key 5 times, then hit the Up Arrow key 5 times. 
What you've just done is push the End of Text Marker out of the 
way. It isn't normally necessary to do this, but it makes things 
neater, and so it's done now, simply to avoid confusion while you 
work through the tutorial. 

The ENTER key works like the Carriage Return on a typewriter: it 
ends the present line, and moves you down to the start of the next 
line. Everything following it is pushed down a line, each time 
you hit ENTER, including the End of Text marker. 

The flashing square you now see at the top left of the screen is 
the Cursor. The Cursor marks your current place in the text. 
It flashes so it can be spotted quickly in the midst of a 
screenful ot letters. 

2 INSERTING TEXT: WORDHRAP 

Now, just type. Type : 

Now is the time to 

This illustrates the :nost fundamental functioning of the Editor: 
Any key hit (except for the Arrow keys, SSIFT, CTRL, CLEA.~. ALT, 
Fl, F2 and SREAK) is inserted into the text directly at the cursor 
position on the screen. The Cursor moves ahead one character 

3 

position so it still points to the same character it st~ ~ at. 
The last typed character is directly "behind" the Cursor (to the 
left of the cursor). 

Now finish the sentence by typing: 

r all good men to come to the aid of their party. 

Notice that as you were typing the word "party", it - suddenly 
shifted to the next line. This is called Wordtofrap. As 80011 as 
you type past the right margin, the program starts a new line tor 
you, and any word you've started is moved instantly down to the 
new line, along with the Cursor. Everything below this point will 
be pushed down a line. 

In typewriter terainology, what's happening is that carriage 
Returns are now done automatically for you, at just the right 
point. You no longer have to decide when to do them and you no 
longer have to do them. As a result, the ENTER key (the 
Computer's equivalent of a typewriter's Carriage Return) is used 
most often to create blank lines in the text or to separate 
paragraphs. 

Now type 4 or 5 lines of anything you want, to get the feel of the 
Editor. Don't worry .about lllistakes. Everythlng you type not only 
appears on the screen,·' but ' is also ·: simultaneously stored in 
memory. The place in memory where · the text is stored is referred 
to as the text bnffer. It can hold from 1 to 48,000 characters 
worth of text. ~t you see on the screen is simply a movable 
window into any portion of the text buffer. 

3 HOVDfG THE CURSOR 

When you've finished typing a few additional sentences, hit the 
Left Arrow key a number of times. With each press the CUrs~r 
moves 1 character to the left. Now, pr~s the Left Arrow key and 
continue to hold it down. The Cursor keeps moving until it gets 
to the beginning of the text. (This point is called the •top of 
text• because it's the very top or start of the text buffer. 
Beyond this'· there.. no where left to go. ) 

Notice 
line, 
text. 
screen. 

that when the left-moving CUrsor got to the beginning of a 
it next went directly to the end of the preceding line of 
That's because the CUrsor will not go just anywhere on the 

It only goes where there is actual text. 

Hit the Right Arrow key a few times. Now press it and hold it 
down for a few seconds, and then, while still holding it down. 
press SHIFT and hold that down for a few seconds. Notice that 
when you hold the SHIFT key down as well as the CUrsor (Arrow) 
key, the Cursor moves even faster. Releasing the Arrow key stops 
it. continue to hold the Right Arrow or SHIFT & Right Arrow keys 
down until the Cursor gets to the End of Text Marker. Like the 
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Top of Tex c the other end of the text buffer, the CUrsor will 
not go past this point. 

Hit Up Arrow a few times and then hold it down. Then, do the same 
with the Down ArrfJIW key. Note that the Cursor will move in the 
direc tion of the Arrow key, but stay at the left margin. Again, 
holding the Up or Down Arrow key down will keep the CUrsor moving 
in the Up or Down direction, and holding down SHIFT at the same 
time will move the CUrsor even taster. At the moment, however, 
there's not enough text in the buffer to show this adequately, 

4 THE CTRL KEY 

The CTRL key (or "Control Key") on the Color Computer 3 keyboard 
is used with other keys to execute commands in the Telewriter 
£ditor. Some examples will illustrate this . 

Hold the CTRL key down and hit the Up Arrow key. The Cursor will 
jump to the top of text (if it wasn't already there). Hold the 
CTRL key down and press the Down Arrow key. The cursor will jump 
to the bottom of the text (the End of Text Marker). Hold the CTRL 
key down and hit Up Arrow again, to put the eursor back ~t the top 
of text. 

Hold the CTRL key down and press Right Arrow. CTRL-Right Arrow 
moves you to the end of the current line. · Hold the CTRL key down 
and hit Left Arrow. CTRL-Left Arrow moves you to the beginning of 
the line. (From here on, instead of saying "Hold the CTRL key 
down and hit Up Arrow.," we' 11 simply say "Hit CTRL-Op Arrow".) 

Changes can be made anywhere in the text, simply by moving the 
eursor there and typing in what's to be added, or hitting the • 
delet e key to delete unwanted or erroneous text (see 5 below). 

To summarize the Cursor commands : 

Right Arrow 
Left Arrow 
Up Arrow 
Down Arrow 

.. JDCJVe Cursor l char right 
= JDCJVe Cursor l char left 
c JDCJVe Cursor up l line 
.. move Cursor down l line 

Cursor to 
Cursor to 
Cursor to 

CTRL-Right Arrow "' 
CTRL-Left Arrow 
CTRL-Up Arrow 
CTRL-Down Arrow -= Cursor to 

end of line 
start of line 
top of text 
bottom of text 

SHIFT- Any Arrow 
Hold Any Arrow 

fast repeat cursor in that direction 
slower repeat cursor in that direction 

Note that the CLEAR key on the right side of the keyboard 
func tions exac tly the same as the CTRL key. Any command such as 
CTRL- Up Arrow, will have the exact s ame effect if the CLEAR key is 
held down instead of the CTRL Key. Wherever CTRL- is used in this 
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111anual, you can substitute CL£AR- . This is 
compatibility with Telewriter-64, and, 
execution of any command with only 1 hand. 

to 1114intain co111111and 
as a bonus, allows 

DELETING TEXT 

Now move the cursor to the "g" in good (in the top line), and hit 
the red BREAK key. The "g" is deleted and the rest of the line 
moves to the left to fill the gap. The Cursor stays put and now 
points at the character ("o") originally to its right. 

Hit the BREAK key again. The "o" is deleted. Hit it again, ~d 
the next "o" is gone. Hold the CTRL key down and hit BREAK. The 
space ~ the Cursor is deleted. So, the BREAK key deletes 
the character at the CUrsor, CTRL-BREAK deletes the char~cter 
directly before the Cursor. 

Hold down the BREAK key for a few seconds and notice that the 
Delete function repeats. Delete the letters "d men to come to" 
this way. Siailarly, CTRL-BR£AK, if held down, will repeat for 
deletes behind the Cursor. Hold it down and delete "time for all" 
this way. (If the repeat rate is too slow or too fast for you, 
don• t worry. We' 11 show you how to change it in Chapter VI. ) 

Now hit CTRL-Up Arrow to move the Cursor to the top of the text 
" " lt CTRL K is the "Kill" again. Hold CTRL down and hit the K ey. -

line comand. It deletes everything from the Cursor through the 
end of the line. Because the Cursor is at the beginning of the 
line, the entire line is deleted and t .he lines below it move up to 
fill the vacuum. 

ALIGNMENT 

After doing the above deletes, you'll be left 
"party" followed by the lines that you've typed in. 

with the word 
Like this: 

party. These are the words that you've typed in. These are 
llOre of the words that you •ve typed in. These are still more 
of your OHO words • 

Now place the Cursor at the "p" in "party" and retype the first 10 
words of the sentence. You'll get something like this: 

N<M is the tiJDe for all good men to come to party. These are the wor• 
s that you've typed in. These are 
more of the words that you've typed in. These are still more 
ot your OMO words. 

Notice that the first line tar exceeds the right margin and 
overflows (wraps around) onto the next screen line. What's more, 
this next screen line falls far short of the right inargin, even 
though there's text following which could fill it out. Situations 
like this can arise on screen when you type into a pre-existing 
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line of text or delete the end of a pre-existing line. It's 
called an overflow or continuation line. and it's the 
occasional by-product of editing a line. 

Hit CTRL-Up Arrow to move the cursor to the N of Now. Hit 
CTRL-Right Arrow and note that the CUrsor moves to the end of the 
~ line on the screen. Now hit Down Arrow, then Up Arrow. 
Notice in moving back up, that the cursor jumps right over the 
overflow portion ot the line, and moves to the actual beginning of 
the line. 

Hit Down Arrow now, and the CUrsor again jumps past the overflow 
portion of the line. The Cursor commands treat a continuation 
line like a single line, even though it might occupy 2 or more 
lines on the screen. 

Hit Left Arrow a few times, and notice that the CUrsor moves onto 
the end portion of the overfi<M line. Though the Up and Down 
Arrow keys won't go to the continuation part of the line, the Left 
and Right Arrows will. 

Since continuation lines make the teJtt look sloppy and can cause 
some confusion with certain editing functions, it is best to 
eli111inate them whenever they arise. For this purpose, the CTRL-A 
(Alignment) function exists. So hit CTRL-A and notice how the 
mess above changes immediately into: 

Now is the time for all good men to come to Party. These are 
the words that you'ye typed in. These are more of the words 
that you've typed in. These are still more of your own words. 

CTRL-A Aligns the text. That is, it pulls short lines together 
and makes sure that each line is as long as it can be without 
exceeding the margin. Thus both fragmented and overflow lines are 
neatly taken care of. As a general rule, hit CTRL-A whenever 
editing leaves short fragmented lines or overflow lines that 
exceed the right margin. 

7 INVISIBLE CARRIAGE RETURNS 

Now hit CTRL-Up Arrow to jump back to the first character of the 
text. then hit CTRL-Right Arrow to move to the end of the top 
line. Notice that the Cursor is sitting at a blank space there . 
This is really an invisible character that marks the end of each 
line. It's called a Carriage Return Character or CR, for short. 

Hit CTRL-: (CTRL-colon) and all the invisible Carriage Returns 
will be made visible (as reverse video Left Arrows). Every line 
on the screen (except a line that overflows) ends with a CR. A 
blank line on screen consists of nothing but a CR. Now hit CTRL-: 
again to ret:urn them to invisibility. (CTRL-: "toggles" back and 
forth between visible and invisible CRs). 
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Now, with the cursor still sitting at the invisible CR at the end 
of the first line, hit the BREAK key. This deletes the Carriage 
Return character. Notice that by deleting the CR, you've created 
one long continuation line as discussed in section 6 above. Now 
hit ENTER and note that everything's returned to nor111al. Hitting 
ENTER inserts the Carriage Return character at the Cursor 
position, 11arking the end of that line, starting a new one, and 
moving the cursor down to the beginning of that new line. 

Hit Left Arrow now, so the cursor is back at the CR at the end of 
the first line. Hit BREAK so the invisible CR is deleted once 
again, and the line below is pulled up into a continuation line. 
Now try another way to clean this up. First, hit the SPACEBAR to 
separate the 2 words that were combined when you deleted the CR. 
Now hit CTRL-A to align the text. Again it returns to noraial. 

Overflow and fragmented lines are simply side effects of editing 
which you should be familiar with so they won't cause confusion 
when they arise. The best approach is to eliminate them with 
CTRL-A as soon as they appear. This will leave you with a better 
looking display and eave you time, since the presence of overflow 
lines can slow certain Editor functions. 

One more effect worth noting involves inserting into a line and· 
Wordwrap. Hove the Cursor to the second space after the period 
following ~he word "Party" in the first line. Now start typing: 

Now is the time for 

after which, your screen looks something like this: 

N°" 1s the tillle tor all good men to come to Party. N°" is the 
tillle for These are 
the t«>rds that. you've typed in. These are more of the "°rds 
that you've typed in. These are still more of your OtCf1 t«>rds. 

Note that as you were typing the word "time", Wordwrap occurred, 
and the text ahead of you on the line, moved down with the current 
word to form a new line. The following text was pushed down a 
line to make room for this new line, so the text now looks 
fragmented. Again, this is a situation where you'd want to hit 
CTRL-A to close up the gaps in the fragmented lines. So, do. 

8 AVOIDING ALIGNMENT - PARAGRAPHS 

But there are other situations where you ~ want short lines 
merged to make longer ones for example, at the end of a 
paragraph. So Telewriter will not merge the end of one paragraph 
with the beginning of the next. as long as you specify paragraphs 
in one of the two standard ways: either by indenting the fir$t 
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line by 1 or more s pa ces, or by l e av ing a bla.'"lk. line (a line 
space) between each paragraph . Thes e two methods are s hown here: 

The first way of indicating separate paragraphs is to separate 
them by a line space . 

This is the second paragraph. The line space before it 
prevents its first line from being merged into the short line 
at the end of the preceding paragraph. 

The second way of indicating paragraphs is to indent the 
first line of each paragraph. 

This is the second paragraph and if a CTRL-A is done , it 
will not be merged into the preceding line . The amount of 
indenting can be as little as ~ space . 

To see this in action, jump to the top of tex t (CTRL-Up Arrow), 
Cursor down to the 3rd line on screen, and hit ENTER. You've just 
broken the text into 2 paragraphs (don ' t worry if happened in the 
middle of a sentence -- this is just for demonstartion purposes). 
Now h i t CTRL-A and voila! Nothing happens. But that's exactly 

. what you want. The 2 separate paragraphs stay separate . 
Alignment doesn't merge them; 

9 AVOIDING ALIGNMENT - LISTS 

If you typed in the following list : 

1 Carrots 
2 Apples 
3 Oranges 
4 Peas 
5 Cauliflower 

and then hit CTRL-A, the alignment process would pull all the 
short lines together so you wind up with : 

1 Carrots 2 APPles 3 Oranges 4 Peas 5 Cauliflower 

(If y ou want to try this yourself , jump to the bottom of the tex t 
with CTRL-Down Arrow, and type in the list . Then hit CTRL-A and 
observe the results . ) 

One way to avoid havi ng these short lines aligned i s to indent 
each line in the list by 1 · s p a ce . This makes the alignment 
routine think each l ine i s t he f i rs t line of a pa r agr aph , so it 
will not combine i t with the preceding line. This works OK if 
you're wi l ling to have your lists indented by 1 or more spaces . 

But there will be situatioms where even indenting by a single 
space will be unacceptab l e. For these situat ions, Te l ewriter 
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provides an "embedded command" that protects specially marked 
blocks of text from being effected by Alignment. Th i s e mbedded 
command _ will be discussed in Chapter V, sect i on 4A, be l ow . 

10 PLAY 

At this point, it might be worthwhile to spend a few minutes 
s imply playing with the Edi t or. Write something with it, or clean 
up or modify what ' s alre ady i n me mory using the cursor and Delete 
c ommands . 

11 READING IN A FILE 

So far, you ' ve been working with Telewriter-128's Editor to write 
and edit text. But , before returning to learn more Editor 
functions , let's do a qui ck digression into Reading in a text 
file. 

Hit the F2 key and you jump ins tant l y to 
the same menu you saw when you first ran 
you access to storing and retriev ing 
cassette and access to the Editor. 
covered fully in Chapter -III . 

the Main Menu. This i s 
Telewriter-128. It gives 
text files on disk or 
Use of this menu will be 

For now, the idea is to Read in the DEMO file that comes on the 
Telewriter-128 disk and cassette . This large chunk of text will 
be used to demonstrate other features of the Editor, after first 
introduci ng you to the process of Reading in a text file . (Note 
that· Reading in a file will destroy anything previously in the 
text buffer , so the words you've just been working with will be 
gone forever . ) At this point , cassette users should skip to 
section 13 . 

12 READ IN DEMO TEXT FILE: DISK 

The Te°lewriter-128 disk has a file on it called DEMO . TXT. To read 
this file in, hit R i n the Main menu. The Menu will disappear and 
the top left of the nearly blank screen will say "Select file to 
read" . Below this , 2 names wi.11 be listed: DEMO. TXT and 
DEM02.TXT -- the former , in reverse video . Simply hit ENTER now, 
and the DEMO . TXT file will be Read in . _(The Read in command will 
be covered in detail in Chapter III.) 

During the Read in, a box w~ll appear at the center of the screen 
with the flashing word "Readin g" and the name "DEMO . TXT" at the 
bottom. When it's done , you'll be instantly returned to the 
Editor , where you'll be looking a t the beginning of the text just 
Rea d into the tex t buffer from t he DEMO . TXT file . 

13 READ IN DEMO TEXT FILE: CASSETTE 

On S ide 1 (labe l side ) o f the Te l ewriter-128 t ape , the DEMO f ile 
immedia tely follows the progr am i tse l f. So , with Side 1 of t he 
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tape in t. ~ecorder • t th 
loading the ~-Jgram, hit a e same point where it stopped after 

the recorder's Play button. 

Now, still in the Hain Menu hit h " " 
command. A box will a ' t e R key to invoke the Read in 
a filename. Simply hi~~~ ~~e center ot the screen asking for 
Read in whatever file is key. This causes the program to next on the tape. 

When you hit ENTER, the word "searchinn" will a in 
and then, a few seconds 1 t h ,. ppear the box 
"DEMO" ill a er• . c ange to "Reading in" The word 

w appear in the lower portion of th bo . 
name of the tile being Read .tn. e x indicating the 

When it's done, 
Editor, and you'll 
just Read into the 

the program will automatically jump back to the 
be looking at the beginning of the text 
text buffer from the DEMO file on th you e cassette. 

14 SCROLLING 

Now, hold down the Down Arrow ke 
the lines, at the left mar in y. The Cursor runs quickly down 
the screen, the text scroll~ u; ~~~ ~e~iit gets to the bottom of 
key down for a few seconds ne. Keep holding the 
rele~ing the key, also hold~e~:xt scrolls by. Then, Without 
speed will noticeably increase. SHIFT key. The scrolling 

This is the Dual Speed Cursor If j 
down, the Cursor moves c 'ti ust the Arrow key is held 
press the Shift key down as :11 nu~usly at one speed . It you then 
rate of speed These 2 diff , e Cursor moves at a faster 
fast or slow, ~sing the Optio:e:n~a7~~a~~r~If~t to any values, 

Now test the dual speed cursor with the Up Arrow and 
text scrolling smoothly down the page. observe the 

15 PAGING 

Scrolling allows you to move 
line. Paging moves you through quickly through the text line by 

the text in larger chunks. 
Hit CTRL-Op Arrow to get back 
Page command. The screen will to top of text. Now hit CTRL-P, the 
will be at the next scr turewrl ite in about a second and you 

ti een of text in your .. _____ _ 
con nui ty. the Page command tak .....,..waent, For 
screen of text starts with ~ Y: 22 lines ahead, so the new 
screenful. (It's like turning to ~he tto~ 2 lines of the previous 
the last 2 lines of the pre~ious nex page in a book, with 
the new page.) page carried over to the top of 

:!~on~T~~=e: few more times. Note that the Cursor appears at the 
line of each new page . 
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To Page in the reverse direction, hit CTRL-- (CTRL-minut .gn). 
You are moved backward by one screenful of text, and the ~-ursor 
now sits at the bottom line of the screen. For continuity sake, 
this bottom line was the top line of the preceding page -- Just as 
though the text had slid quickly down 23 lines. 

16 FINDING A STRING: DIALOGUE BOXES 

The Find co111111a11d allows you to quickly search the entire text for 
a precise string of characters that you specify. To see the Find 
command in action, jump to the top of text (CTRL-Op Arrow) and hit 
CTRL-F (Find). A rectangular "dialogue box" will appear at the 
center of the screen. · 

Dialogue boxes are U.Sed throughout Telewriter-128 as a way to pass 
information between the progr- and the user. They generally work 
the same, regardless of the situation: 1) To edit a line you're 
typing into a dialogue box, use the Lett Arrow key to delete the 
previous character. 2) To get cleanly out of a dialogue box 
without its operation being performed, hit BREAK. 

At the top of a dialogue box, there'• usually a "prompt" asking 
for certain information. In the case of "Find", the prompt asks 
you to "Enter string to find.• Below the prompt is a flashing 
Cursor, waiting for your input. You can now type in any etring of 
characters you'd like to Find in the text. ~you bit ENTER to 
terminate the string, the command goee into effect. So type in: 

the 

This is called the "search string" because it's the string of 
characters you're searching for. Hit ENTER now, and, after the 
dialogue box disappears, the Cursor will be sitting at the first 
instance of the word "the" that it finds. To find the Next one, 
hit CTRL-N. The cursor will be sitting at the next "the"-.--

Hit CTRL-N a few more times. The Cursor will jump to the next 
occurrence of the string "the" each time. If it's not on the 
current screen page, it'll jump to a new screen page. When it can 
find no more instances, it stays put at the last one it's found. 
If you jump back to the top of text (CTRL-Op Arrow), and hit 
CTRL-N, it'll move through the text once again, finding each 
successive occurrence ot the search string "the" . 

The CTRL-F and CTRL-N 
Cursor position and 
text. This means that 
search with the Cursor 

commands st~t 
search in the 
to search the 
at the top of 

their search at the current 
forward direction through the 
entire text, simply start the 
text. 

The Find and Next commands are useful, not only to find a certain 
word or string for modification, but also as a way to move quickly 
to a given point in the text. 
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\ 
-- What Can Yv- Search For? 

The "str1ng" you search for can be anything -- a single letter, a 
word, a group of words -- upto 29 characters long. If you search 
for a phrase of more than one word, it will be found even if it's 
broken up by the end of a line. (To do this, the Find routine 
will allow a Space character in the search string to match a CR 
(Carriage Return) character in the text.) 

The search string can contain any character you can type on the 
keyboard (letters, num~rs, symbols) and, in addition, you can 
include certain special characters. 

For example, the ENTER key normally ends the input of the search 
~tring and executes the Find command. But if you want to 
include a Carriage Retun in the search string, you can do so by 
simply hitting CTRL-"ENTER. A rev~rse video Left Arrow appears in 
the string when you do this, to indicate the presence of the CR 
there. 

Similarly, a number of other "special characters" discussed later 
in this manual (like: Begin and End Markers, embedded control 
characters, and embedded format commands) can all be included in 
search strings si!llply by hitting the exact same key combinations 
that ;,n~oke them in the Editor (e.g. hitting CTRL-B puts a uBegin 
Marker ln the search string). 

L 1 GLOBAL SEARCH AND REPLACE 

A simple extension of the Find feature is Global (or selective) 
sea:,ch ~d replace. Essentially you search for a given string as 
in Find , but now, each time you find it (using CTRL-N), you have 
the option of changing it, with a single COIDllland, to another 
string of characters you've specified. 

Go to the top of text again and hit CTRL-G (Global search & 
replace). The dialogue box will appear as it did in Find. Type: 

the 

and hit ENTER. The cursor will now drop down a few lines in the 
dialogue box and prompt you with "Enter replacement string" Type 
in the word: · 

some 

and hit E.~ER. When the dialogue box disappears, the cursor 
be sitting at the first found instance of the word "the". 
CTRL-R (Replace), and the word "some" will replace "the". 
CTRL-N a few rnore times and selectively change some of the 
few instances of "the" to "some", just by hitting CTRL-R. 
replacing text this way leads to some fragme~ted lines, feel 
to re-Align them at any point with the CTRL-A command.) 
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To move rapidly through a Global search and replace, hold the CTRL 
key down with one finger and rest 2 other fingers on the N and R 
keys, so you can alternate easily between the two. 

If you want to delete (rather than replace) the same string a 
number of times, you'd follow the same procedure, but type nothing 
in when the dialogue box requests a "replacement string". 
Instead, just hit ENTER. This will cause the found string to be 
replaced with nothing -- i.e. deleted. 

18 WILD CARD SEARCH 

You may specify an "incomplete" string for the Find and Global 
search and replace commands. If an Up Arrow (t) is included in 
the search string (by hitting the Up-arrow key on the Color 
Computer), that position in the string will match any 
character. Because of this, .the Up Arrow is called a "wild 
card". You can use any number of "wild cards" in a given string. 
For example, hit CTRL-F and type in the search string: 

tbete 

Now, when you go through the text with CTRL-N finding instances of 
this string, you will match words like "there", "these", "theme", 
and "the end". · 

19 BLOCK COfoMANDS: BEGIH AND END MARKERS 

There are ti.mes when you want to effect a chunk (or Block) of 
text all at once . The Block Move, Block Copy and Block Delete 
operations work on chunks of text that may be many paragraphs long 
or only a few words or a few letters long. 

The Editor provides a simple way to mark the beginning and end of 
the chunk of text you want to deal with. To see this, jump to the 
top of the text and hit CTRL-B. A reverse-video, right-pointing 
square bracket appears on the screen at the Cursor. This is the 
Begin Harker, and it designates the start of the block of text 
you will be dealing with. 

Now, cursor down 2 lines and press CTRL-E. A reverse video, 
left-pointing square bracket appears at· the beginning of the 
line. This is the End Harker and it marks the End of the block 
you will be dealing with. 

The "Begin" and "End" Markers can go anywhere -- at the beginning, 
middle or end of a line -- but, if both markers are used, the 
Begin Marker must Precede the End Marker. 

You can only set one Begin and one End Marker at a time. If, say, 
an End Marker is already set, and you set another one somewhere 
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else in the text, the first one w1ll be deleted. The same is true 
if you set a Begin Marker when another Begin Marker ls already set. 

20 BLOCK COPY 

Before ma.Icing a Block Copy of the text you've just marked, let's 
first make some space so the Copy will be obvious. Move the 
CUrsor to the top of text, hit ENTER twice, and cursor back up 2 
lines to the top. 

Now, press CTRL-C (for Copy). The 2-line block will be copied to 
the current CUrsor position. The screen will be rewritten, the 
Begin and End marks will be deleted and the CUrsor will be sitting 
at the beginn1ng ot the block as copied. The original of the copy 
is left intact, where it started, a few lines away on the screen. 

You can Copy a block to any place in the text, but you cannot Copy 
a block into itself . You can, however, use Block Copy to copy a 
line of text from the Editor, into a "Find" or "Global replace" 
dialogue box, to be used as e1ther a search or replace string. 

21 BLOCK HOVE 

Block Move, works exactly like block Copy, 
not left intact. The original is deleted. 
"moved" from its or1ginal place .in the text 
is when you hit CTRL-H (the Hove command) . 

except the or1ginal is 
Thus, .it's been truly 
to wherever the Cursor 

Let's illustrate this by JDOving the copy you just made. With the 
Cursor st.ill at the top of text, hit CTRL-B. CUrsor down 3 lines 
and hit CTRL-E. You have now surroWlded the block you just copie~ 
(plus a blank line) with a Begin and an End Marker. 

Cursor down, now, to the first letter of the first word of the 
second paragraph, and hit CTRL-H (Move). The screen will refresh 
and the 2 lines you had marked at the top of the screen, w.111 have 
been moved to the 2nd paragraph. Note that the blank line has 
been moved as well, and separates the moved chunk from what was 
formerly the 2nd paragraph. Also note that the Begin and End 
Markers are gone after the operation is done. 

The maximum size of a block of text to be moved is about 8,000 
characters. If you exceed this size, a dialogue box w.111 appear 
telling you that the "Operation is too big" and giving you the 
amount it's too big by. 

22 BLOCK DELETE 

Block Delete is a Block operation like Copy and Move, except it 
DOES NOT use the Begin Marker, and, a s its name implies, it wipes 
out a chunk of text. 
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to the end of the 1st paragraph and put an End 
Move the Cursor Jump back to the top of the text. The 
Marker there (CTRL- E). -X) will delete the chW'lk of text 
Block . Delete co1111Dand (CTRL (The Cursor must always between the cursor and the End Harker. 
come before the End Harker in the text buffer.) 

A dialnnne box appears asking you So hit CTRL-X (X for eXcise). -·- ' about to irrevocably 
if you' re sure. This is because you re to lose it, hit 

f t t It you're sure you want ~es~~c~~ othe~~ration (hitting any other key will prevent 
the delete froa happemling) · 

· 11 di ar Note that the chunlc of text you've marked wi -ppe • blank 
The .. ed" There are no leftover entire block has been re1110v - the End Marker is 
lines. """w • - it.h the other two block operations, 
gone as well. 

23 OVERSTRDtE K>DE 

, 1n I:lsert Mode. That is, you just In Telewriter-128 you re alwaysd ...... _ er the Cursor is, on screen 
type and text is always inserte "'~rev 
and in the text. · 

"type <:Ner" something But somethles it's 1110re efficient to jus!c,_thing new. If you hit 
than to delete it first ~ type b~ to do just that. Now, 
CTRL-0 (overstrike Mode) you ll beundea the Cursor will be replaced 
when you ~z~· h cursor will JDOVe one character o 

..__ the character . r t 

by whatever key you hit and~ ted only changed (replaced). the
0

right. Nothing w.111 be er ' 

changes from a flashing So, hit CTRL-0. Notice that the CUrs~s tells you that you're in 
black square to a flashing line. t it and type "12345" 
overstrike lllOde. Go to a line withltex o~ ... - character that was 

how ach nuinber rep aces UJC lr:s 
and notice e delete key (BR.!Alt) still wor as 
formerly there. Notice that the ACEBAR .111 1nsert a single Space 
usual.· Also note that CTRL-SP w tul when you suddenly 
(only· in overstrike Hodel· This c:c, ~hout leaving overstrike 
want to insert a charhacster ce o~an always be overwritten.) lllOde. (Once inserted, t e pa 

1nse t mode hit CTRL-0 again. Notice that 
To return to norm.al r '1 flashing black square. It is 
the cursor ch~ges back to the ~ you if you're in Overstrike 
useful to have something rem i ific~t chunk of text by 
mode -- otherwise you can delstroy ~h~~you're just inserting. blindly typing over it, whi e you 

h 's no more text to type over, At the end of a line, where t ere i t l:IOde with Wordwrap and 
j ust like regular nser ' d 

overstrike acts hit ENTER while in overstrike mo e, 
everything. If, however, you usual but the character 
you will get a carri~~~ t!eg~ -~replaced by the CR. formerly at the cursor w 
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24 CHARACTERS PER LINE 

You can change the length of the lines of text on-screen 
(Characters per Line or Chars/Line) at any time with the CTRL-@ 
command. Chars/Line is the width of the lines on screen and in 
the printout, and it sets the point in a line where Wordwrap will 
occur and where lines will be cut by the Align (CTRL-A) collUllalld, 

Hit CTRL-@ and a dialogue box 
value of Chars/Line, with 
input. When Telewriter first 
63. 

appears, telling you the current 
a flashing Cursor waiting for your 
starts up, Chars/line is set to 

Type in the number 50, and hit ENTER. The dialogue box goes away 
and the screen rewrites, but now it's much narrower than before. 
The text has been realigned so no line exceeds 50. To return 
things to the way they were, hit CTRL-8, type 63 and hit ENTER. 
The text widens out again to a line width of 63 Chars/Line. 

The maximum value you can type in for Characters Per Line is 121, 
but, since the width of the screen is 80, and since the maximum 
width of the print line on most printers is 80, you should 
generally type 1n a number less than 80. Standard . typewriter 
lines tend to be between 60 and 70 characters long, so a nlllllber in 
the mid-60's usually worlc.s pretty well • . .,· .'. _.,, 1 , • 

. l 

Note that it you 'do set Characters Per line to a number greater 
than 80, the text you already have on screen will turn into a 
jagged mess, and when you type in n.ew stuff, wordwrap will occur 
at the far right margin of the screen (column 80). Even alignment 
won't be able to clean this mess up. 

Chars/Line can also be set from the Format Menu, and more 
information on that will be given in Chapter rv. 

25 40/80 COLOfi l«lDE 

The optimal way to do serious word processing is with the 
80-column display that the COlor COmputer 3 provides. However, 
since this generally requires a Monochrome or RGB Monitor to look 
decent. the Color Computer 3 also provides a 40-colwan screen to 
be used with those TVs that can't handle the 80-column display 
(some TVs can). 

By hitting CTRL-0 (CTRL-Zero), you can shift Telewriter-128 into 
this 40-colwan mode. The characters are bigger and thus more 
readable on a TV, but a 40-column line loses the "feel" of the 
actual document you're working on. 

So we recommend you avoid the 40- column mode if you can, but, if 
you have to u.se it, Characters Per Line (CTRL-@) must be set to 39 
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while you're in the Editor . This is important in order for 
alignment (CTRL-A) to work properly to get rid o! overflow lines. 
and to .keep things neat appearing on the screen. 

Use this 39 character line in the Editor, and then, when you go to 
Print, re-set Characters Per Line in the Format Menu to the actual 
line width you want the text printed at (like 64 or 68). See 
Chapt IV tor ruore on Chars/Line. 

To get out of 40-column mode, just hit CTRL-0 again. This toggles 
back and forth between the 40 and 80 column mode. 

26 KEYCLICK 

If you're using a TV or a monitor with auftio input, Telewriter-128 
can produce an audible click each tilDe a key is pressed. CTRL-L 
will toggle back and forth between Keyclick ON and Keyclick OFF, 
each time you hit it. 

27 AOTO SPEED l«lDE 

Once you have large amounts of text in the text buffer, typing 
speed (inserting and deleting) would normally get a little slow 
when you edit in the early part of the doCWDent. That's because 
all the text ahead of the cursor must be pushed forward to make 
room for a newly inserted character (or pulled back to fill . the 
gap left by a just-deleted character). The more text there is to 
push or pull, the longer it takes. 

Normally, this delay isn't noticeable to the user until there are 
about 13,000 characters (about 6 typed pages) ahead of the Cursor. 
But at that point, fast touch typists would start to notice a 
slowdown in response to their typing speed. 

Telewriter-128 completely avoids this problem with its "Auto Speed 
Mode" feature. Whenever you lllO'Ve into the earlier parts of your 
document to do some editing, Telewriter senses this and shi~ts 
into Auto Speed Mode. You can now insert and delete at top speed, 
without noticing any slowdown (even if there are 48,000 characters 
ahead of the cursor!). 

Since Telewriter uses your first keypress (an insert or delete) in 
this earlier part of the document to switch to Speee Mode, there 
is a very slight delay at only this very first keypress. From 
then on, response to your typing is instantaneous. Only when you 
move to a different place in the document (more than 500 
characters away) will there be another slight delay as Telewriter 
readjusts the Speed Mode environment. 

Dut. in general. you never really need to 
Just cursor wherever you want and type 
remember that if you're working on a 
(greater than 20.000 characters) and you 
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think about Speed Mode. 
at your top speed. Just 

fairly large documer.t 
jump arol!nd !nto earlier 
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parts of Jt to do some edltlng, you will occasjonally experience a 
tiny delay at the very first keypress in a new section Th if 
you immediately start typing at top speed when yo~ tirs~si:iove 
~~mep:~ce new in the docu.inent, you may lose a keystroke or 2 after 

e rst. But, from then on, you can continue typing at 
usual speed. your 

28 DISABLE WORDolRAP 

~~e general, Wordwrap is an important word processor feature But 
re are occasionally times when you don't want the end of' the 

line to break cleanly at the margin as you type, You might 
to control things yourself without the program interfering want 
its automatic Wordwrap. with 

For these occasions (which most of 0 will 
CTRL-0 (Disable Wordwrap) will turnyW~rdwrap o~~verWi~~c~un~), 
~~ab~~· your typing will just continue to the end of the ~ere:~ 
word) ~~ wra~ ~und to next line {probably in the middle of a 
with •one ~u on t explicitly hit ENTER. You can, thus, wind up 

ig continuation line -- severely degrading th 1 i 
of.,t_he .text and the perfonnance of the system. e c ar ty 
To'" t·;· -. ' 

pu ,.,Wordwrap back into operation hit CTRL-W (Wordwrap). In 
general it · is not a good idea to di~ble Wordwrap __ but 
should be aware of this feature, in case you 
acci~entally hit CTRL-o. It you suddenly notic~ne day, you 
failing to Wordwrap when you type, hit CTRL-W your lines 
the overflow lines with CTRL-A). (and then clean up 

29 HELP 

Telewriter-128 has a lot of features and 
codes. To help you learn, and to refresh ~~ot of commands and 
need it, Telewriter provides 8 pages of On-iine H:1mory when you 
list all the Telewriter-128 Editor commands 11 p. These pages 
format commands, and other special characters~ a the embedded 

To see the Help pages, hit CTRL-H. The text il 
on scr by w l be replaced - een the first page of Help, whi h co d c lists the Edi tor mm.an s. Any key you hit now, will 
through the help screens. Hitting the r:;v:~u, page by page, 
back to the text, while hitting a number key fromker_;ill talce you 
you directly to that page of Help. Hitting CTRL-- (~ii-m1~: 
sign) will move you back a page in the help screens. 

30 INFO 

There are a nW'!lber ot useful Pleces of information 
give you if you hit CTRL-1 (Info). Do it 
window'' will appeilr at the center of the sere~~~· 

Telewriter will 
and the "Into 

This window tells you where you are in the current line (At 
column), what line you're in relative to the start of the text (in 
line) ~dhow many lines are in the text buffer now (total lines). 

H!t any key now, except BREAK, and you'll get a 2nd Info window 
telling you the approximate word count (total words), what 
character you're at relative to the start of the text (at 
character), how many characters are in the buffer (total 
characters), and how 11Uch room is left in the butter tor more text 
( tree space) . 

Hit any key again and you'll see a third window which tells you it 
overstrike lllOde is ON or OFF, if Wordwrap is ON or OFF (enabled or 
disabled) and if "Find ignores case" is ON or OFF (more about that 
1n Chapter VI) • 

Hit any key again, and the window disappears and you're back in 
the text. Hitting the BREAK key in any window before this, would 
have had the same effect. In the 2nd or 3rd windows you can hit 
CTRL- and back up to the previous one. 

It a Begin or End Harker is set, the Harker itself will appear in 
all 3 Into windows. If the End Harker is set, the "In line" will 

. always : .be · 1, : and ' "Total ::•lines", "Total words", and "Total 
characters" . will indicate " the amount of text between the Cursor 
and the End Harker. :. · 

If you have a lot of text in the buffer, the first Info window 
will• take a few seconds to appear, but moving between the 3 
windows from that point on will always be instantaneous. 

31 SPEED 

Telewriter-128 can generally keep up with the fastest typing 
speeds. However, if there are any characters ahead of the Cursor 
on the line, when Wordwrap occurs, it may miss the next key if 
it's typed in very rapid succession. 

This will only be of concern to fairly fast typists, and will 
~ be a problem if the Cursor is always at the very end of 
the line as you type. That is, the cursor should be at the 
invisible CR character whenever you're typing in new text at top 
speed. If even a space follows the Cursor, it may miss the next 
typed character immediately after Wordwrap occurs. 

If you notice that characters are being missed at the beginning of 
lines, right after Wordwrap, simply hit CTRL-Right Arrow. This 
will move you to the true end of the line. Delete any excess 
spaces and Continue typing from there. Typed characters will not 
be missed from that point on. 

If you are editing into a pre-existing line and want to avoid the 
problem, hit ENTER at the point where you're typing in. and hit 
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Left Arr\ ,n 
continue t ce, so you're now sitting at th d 

. _ .ng from there. When , de en of a line, and 
rejoin the line ou you re one, hit CTRL-A to 

y artificially broke when you hit ENTER. 
32 SPECIAL KEYS 

Along with the standard k eyboard ch t provides a few extra Ho arac ers, Telewriter-128 
number: ALT-1 is I ALT-3 1~ ~e generated using the ALT key and a 
ALT- - is ( d (tilde) ALT- 8 is [ 
( _ un erline character) ALT / i \ ALT-9 is ] 

and ALT- is } Th - s (backslash) ALT-, is 
will be d. i . . ere is also a TAB k CT 

scussed in detail in Chapter v. ey, RL-ENTER, which 

33 MEMORY FULL 

When you run out of room i th 
with 48K of text:) d~ e text buffer (when you've filled it 
"memory full". Hit ~y akey a;:1'1~~x will appear with the message 
return to the text. the dialogue box go away and 

It you now try to type at this 
the "memory full" Point, you Will just keep getting 

error until you delete so111e text. 

There are a number of wa t 
typing in new text ar th~ pr~ceed from this point. It you are 
Save (explained in the next ch:~t of the buffer, you could partial 
current text butter and th d er say, the first halt ot your 

• en elete it, so you can continue on. 
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III. THE MAIN MENU 

l OVERVIEW: STORAGE AND RETRIEVAL 

2 

The Hain Menu serves as a gateway to the Editor and to the other 2 
menus (the Format and Options Menus), but its main function is 
Saving what you write to disk or cassette, and Reading saved tiles 
back into Telewriter from disk or cassette. 

Since disk and cassette work somewhat dittereLtly, and since there 
are a tew differences between the cassette version's Hain menu and 
the disk Hain menu, we'll describe the disk commands in section 2 
below, and the· cassette commands in section 3. It you have 
Telewriter-128 on cassette, skip section 2 and read section 3. If 
you have the disk version, read section 2 and, optionally, Section 
3, since the disk version can access the casse tte Hain menu as 
well. 

DISK ACCESS 

Hit the F2 function key while in the Editor (or any other menu, 
for that 111atter), and you'll jwnp immediately to the Hain menu. 

This menu consists of 2 columns . The left column has. 8 commands 
all of which deal with files on disk. The right column has 6 
commands, all of which take you to other places in the program. 
Each command is invoked by hitting the key corresponding to its 
(capitalized) first letter. The Hain menu cOllllllarlds will now be 
described in order. 

A. READ IN FILE 

The "Read in file" command (R) allows you to read a text file from 
disk into the text butter, where you can work. on it with the 
Editor. 

So, with a backup of the Telewriter disk in drive 0, hit the R key 
in the Main menu. The Menu will suddenly disappear, the prompt 
"Select file to read" will appear at the top of a blank screen, 
and all the text files on the disk will be listed there. (Non 
text files, such as programs, will not be listed.) 

The Telewrlter-128 disk, has only 
receive it: DEMO.TXT & DEM02.TXT, so 
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that the first name in the list appears in reverse video. This is 
actually the result of a large cursor sitting on the name. Hit 
Down Arrow and notice that the Cursor moves to the second name and 
now that appears in reverse video. If there were more files, 
hitting Down Arrow would move the Cursor to them, one at a time. 

Hit Up Arrow and notice that the cursor moves back up to the · first 
filename. So, to read a tile from disk into the Telewriter Editor 
(into the text butter), simply cursor through the list of tiles on 
screen and hit ENTER when the Cursor's on the one you want. (On 
some monitors, you may have to play with brightness and contrast 
controls to be able to read the reverse video name clearly.) 

So, put the reverse video Cursor on DEM02.TXT and hit ENTER. A 
dialogue box will appear with the word "Reading" flashing at the 
top, and the name ot the tile (in this case "DEM02.TXT") displayed 
at the bottom. When the file.is done reading in, the box will 
disappear and you'll be back in the Editor, looking at the first 
page of the DEM02 file on screen. 

Note that once you've hit R and gotten the file listing, you can 
change your mind and not read anything in. To get out of Read in 
mode, and back to the Main Menu, simply hit the BREAK key. As a 
general rule, the BREAK key will get you gracefully out of 
dialogue boxes and tile listings without chang.ing anything and 
with no damage done. 

B. SAVE PILE: FILENAME CONVENTIONS 

The Save f.ile command allows you to SAVE all your current work to 
disk. So hit S, and a dialogue box appears with a flashing Cursor 
at the bottom. Above it is the prompt: "Enter filename". So type 
in the filename TESTPILE and hit ENTE..~. (Remember, if you make 
a mistake typing something into a dialogue box, use the Left Arrow 
key to back up and retype it.) 

The word "Sav.ing" will flash at the top of the dialogue box and 
the filename you've given will appear at the bottom. When the 
Save is complete, the box goes away and you're still facing the 
Main Menu. Hit F (Pile list) and all the files on your disk will 
be shown. Notice that TESTPILE TXT is among them. 

Remember that when you Save a file to disk, if a file already 
exists on disk w.ith the same name, all text in that disk file will 
be wiped out and completely overwritten by what you Save now from 
the current text buffer. Though this can be devastating if done 
by accident, it's precisely what you want to happen when you're 
updating a file (see section C below). 

Note that the filename you type in must conform to the standard RS 
DOS filename format as described in the Radio Shack Disk Basic 
Manual . That is. the name can have upto 8 characters (letters. 
numbers, and most of the symbols or. the keyboard) followed by an 
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optional extension which ls a slash {/)or a period (.) followed 
by 1, 2 or 3 characters. Thus A.TXT, 8LETTERS.TXT, A.l, l.A. 
LETTER..023, are all legal filenaD1es. 

If you do not supply an extension when you Save a file, a /TXT 
extension will automatically be added. (You typed in only 
"TESTFILE", but the d.isk directory showed it as TESTFILE . TXT.) If 
you include the / or the . but no extension, then no extension 
will be added. ) 

A colon and a drive number can also follow the filename. If you 
have more than one disk drive, this will direct the file to the 
dr 1 ve ot your choice. Thus. NOTE. TXT: 1 wi 11 save the current text 
Wlder the naJDe NOTE.TXT on the disk in Drive 1. See "Default 
Drive" below for more on this. 

If you hit the s collllllal\d and then decide not to Save anything, 
just hit the red BREAK key and you'll be back 1n the Hain Menu. 

To significantly INCREASE THE SPEED OP SAVES AND READS, format 
your blank data disks with the RS DOS co=nand: DSKINI0,6 (instead 
of just plain DSKINIO). 

C. QOIClt SAVE; DEFAULT FILENAME 

Often, . a word processing session will consist of: reading in a 
file you've been working on, spending a few hours adding to or 
editing it, and then re-saving it, to be worked on more, later. 
usually the file keeps the same name, so that when you re-save it, 
the old version is replaced by the latest version. 

To protect against power failures or sudden machine crashes, it's 
usually good practise to save the file (and thus all the latest 
updates) every few minutes. The "Default filename" makes it easy 
to do frequent saves by eliminating the need to type in the same 
filename each time. 

so hit s in the Main menu, now. to get the Save dialogue box. At 
this point you'd normally type in a filename and hit ENTER, but, 
instead, iook at the 2nd line in the box . It says "Default File: 
TESTFILE. TXT''. That means that if you simply hit ENTER now 
(instead of typing in a filename), the current contents of the 
text buffer will be · saved Wlder the "default" filename: 
TESTFILE.TXT. (A "default" is a preset name or value that gets 
used if you don't specify a different name or value.) 

"Default file:" in the Save dialogue box, is always set to the 
name of the last file Saved or Read in. In this case, you had 
just Saved TESTFILE.TXT. and when you did so, that becaJJ1e the 
"Default file". 

Now, everytime you make some changes to it in the Editor, just hit 
F2 to get to the Main menu, hit S to get the Save dialogue box, 



6.i .......... ·-·· ·-· .... 

and then ;ust hit ENTER. 
filename the updated t Since TESTFILE is the current default 
b k • d con ents of the text buffer will be saved 
ac to isk as TESTFILE: h ti 

disk can be updated without ~h=ac d mte. In this way, the file on 
Save it. nee 0 type in its name when you 

But there's an even easier way to do all 
the Edit this without leaving or. So go into the Editor -_s_o_m_e--" ... h=.,.,= and pretend you've just made 

c anges to the text and want to re-save it ·now. 

Hit CTRL-Q (for Quick Save) and a dialo e bo 
over your text, exactly like the S di f1 x will appear right 
Menu Noti tha " ave a ogue box in the Hain 
ENTER and ~e t the default file:" is TESTFILE.TXT. So hit 
back und an i~he current (updated) version of the text is saved 

er s original name (TESTFILE TXT) Th th 
box disappears, and you're still right in.the text.en e dialogue 

Tlhus, every few minutes, as you work, you can instantly Save the 
atest updated version of TESTF 

then ENTER, right from the I~~i~~~-by just hitting CTRL-Q and 
always have the latest update of your This makes it painless to 

work on disk. 

Of course, at any poi t 
into the dialogue bo.x an~ hirou can type a completely new filename 
text buffer will be S d undENTER. The current contents ot the 

ave er that name and that ill 
become the new default filename. ' name w now 

D. APPEND 

:;:~ Append COID!lland works exactly like Read In. You hit A in the 
lis~ thl!lentu, use the reverse-video Cursor to select a file from the 

a appears, and hit ENTER. Th fil 
read into the text b ff b e e you've selected is now 
already there (as Read I~ d~~). u~heinstead of replacing what was 
added onto the end of what you have in new file is appended or 

the buffer already. 

If the file you're Appending, plus the text 
exceeds the space available i already in the buffer, 

i bl n melllOry. Te lewr 1 ter reads 1n h 
as poss e and then reports "Me1110ry full" i di l as muc 
any key and you'll be backin · na aoguebox. Hit 
something before you can type an th~e Editor, but you must delete 
section 33, for more on the Memoy fugllmore in. (See Chapter II, 

ry condition.) 
E. ~SAVE 

~f (her, cent) or "partial" Save allows you to save to disk a part: 
w at s in the text buffer. Before invoking this 

must first designate the chu.'lk of text to be Saved co111111and you 
by first putting an End Marke~ (CTRL E · You do this 
moving the Cursor to the ~'~t: h - ) at the end of it, and then 
b i Thi i · - · w e?"e you want the Pa~t•al Save to 
eg n. s s all done, of course, in th~ Edito~ (No~e· Use the 

Cursor to designate the start of the bl k •· · 
Begin Ma~ker!!) .oc. to Save. Don't use the 
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Then. go to the Main Menu (F2), and hit•· A dialogue box appears 
and, from here on, everything works exactly as it does in the Save 
dialogue box: you give a filename and hit ENTER (or just hit ENTER 
to use the default filename), and all the text in the Editor 
between the CUrsor and the End Marker will be Saved to disk under 
that name. 

Note that after a •save, the End Harker will still be -t in the 
text. If you do not intend to do another block cocmand on the 
same block (e.g. a block delete), then you should probably delete 
the End Harker. 

P. PILE LIST 

If you hit F in the Main Menu, the names of all Files on disk will 
be listed on the screen in the standard RS DOS format. If you 
have more than l drive, the tiles on the disk in the currently set 
"default drive" (see section .1 below) will be listed. 

At the end of this Directory listing, Telewriter prints the number 
of tree granules remaining on the disk. If the listing exceeds 
the size of the screen, you can pause it with the usual Basic 
Shift-8 comiand, amd, then, hit any key t? continue it. 

When the listing is done, the flashing cursor will appear below 
the last line. Hit any key to return to the Main Menu. 

G. . ICJ:LL DISX: FILE 

This is the same as the RS DOS "KILL" command. Hit K in the Main 
Menu and all the tiles on disk will be listed. use the Down Arrow 
and Up Arrow keys to put the CUrsor on the name of the file you 
want to Kill . Then hit ENTER. 

Before the file is deleted, a dialogue box will appear asking you 
if you're sure (once you Kill a disk file, it's gone for good) . 
Hit Y and the file will be deleted. Hit anything el- and it 
won't be deleted. Either way, you'll be immediately returned to 
the Main menu. If you want to get out of the ICill command and 
return to the menu without killing anything, just hit BREAK. 

H. CHANGE FILENAME 

To change the name of a file on disk, hit C (Change filename) and 
all the disk files will be listed on screen. eursor to the 
filename you want to change, and hit ENTER. 

A dialogue box appears with the name just selected at the top, 
followed by the prompt "Enter new filename". Type in the new name 
and hit ENTER. When it's done, the dialogue box disappears and 
you're back in the Main Menu. A File list (F) will reveal that 
the new name is there and the old name is gone. 
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Note that if no extension is given 
original extension will be used. 

I. PRIHT PILE LIST 

The "Print file list" 

With the new filename, the 

disk to your printer i~o~Swfill print the naJnes of all 
box will ormat. When you hit P a appear, asking tor an ID Th • 
the printout so you know what disk lt'f is will allow you 

s or . 

files on 
dialogue 
to label 

After you type in an identifyin 
will print the ID space once g la~~ an~ hit ENTER, the printer 
followed by its.size and th , pr n t e name of each file 
at the end. Then, the dial~~·~~in11ihe number of free granules 
in the Main Menu. w go away leaving you back 

Note that you must ha ti -
ve rst set the appropriate BAUD rate your printer in the Telewrit 

Also, if your printer is nots te~ ~ormat menu (see Chapter 
the na!Des will be printed e o o auto-line feeds, then 

over each other on the same line. 
:J. DEFAULT DRIVE 

tor 
IV). 
all 

If you have more than one disk dri . 
which drive will be accessed by a i ve, you need a way to specify 
set the Default Driv g ven COlllllland. To do this, you 
command in the Hain M!~u Th~~~ber following the "Default Drive• 
selected (If h ' cates which drive is currently · you ave only l drive i 1 1 to 0 at all times.) • s mp Y eave this value set 

Thus, if you hit the F COlllllland (Fil 
set to l, then the listing that e List) and Default Drive is 
the disk in drive 1 If appears on the screen will be for 
to l, then that fil; willybeou Savede a file, and default drive is set 

sav to drive l. 

Note that you can override the Default 
Save, by specifying the drive you want in 
even though Default Drive may be' 
LETTER.TXT:O would be Saved to Drive 0. 

Drive setting when you 
the filename. Thus, 

set to l, the filename 

To set Default Drive, hit 0 in the 
a Hain Menu. A di l bo ppears with the current value Hit th be a ogue x 
~r 3) and then hit ENT£R .. The diale n:U r you want (O,l,2, 
Default Drive" in the Main Menu will ~ow box will disappear and 

number you just set. be followed by the 

There is also a shortcut for se-tting the Default 
Main Menu, simply hit the number 0 Drive. In the 
flash and Default Drive will now be • 1 • 2 • or 3. The screen will 
hit. Thus, if Default 0~1ve is set to whatever number you 
examine the files on driv~ l jus~e~i~olo~hand you wish to quickly 
look at drive o, just hit 0 ~her. F. · en F. To jump back to 
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Beware of setting Default Drive to a drive number you don't 
have. For example. say you have just one drive (drive O), and 
Defauft Drive (accidentally?) gets se t to 1. It you then do some 
disk operation (File List, Save, etc.) the disk will be silent tor 
about a minute and nothing will appear to be happening. 
Eventually, there will be an error message, from which BREAK will 
return you to the menu. But during this wait , it ' s easy to panic 
and thi nk the system has crashed -- so always check the value of 
Default Drive first, in these situations. 

Note that Telewriter will not let you set Default Drive to any 
number other than 0,1,2, and 3, but you can still set it to 3 even 
if you have only 1 drive . 

IL DISlC ERRORS 

Telewriter-128 Disk error messages appear in the top border ot the 
dialogue box. When an error message occurs, hitting any key will 
get you out ot the box and back to the Hain Menu. The possible 
disk errors are as follows: 

1) Disk full error : Possibly some , but probably not all ot the 
file has been -ved to the \'lislt befor e it ran out of roo111. 
Re-eave the tile to another disk with enough room, and delete 
the incomplete file first saved, to avoid future confusion. 

(Note: If "Auto fi l e backup" is ON and there's a TW•BAK.TXT 
file on the disk, delete TH•BAK.TXT, turn Auto file backup OFF 
in the Options menu and then try the Save all over again. See 
Chapter VI on the Options Menu for 1DOre information.) 

2) Bad Filename Error: 
characters in the name 
Nothing happens , the 
disk. 

Your filename is too big (more t han 8 
or 1DOre than 3 in the extension). 
program doesn't even 'try to go to the 

Solution: type in a legal filename (note: avoid use of period 
(.) or slash (/) or colon (:) except as separators for 
extension or drive number. See Radio Shack Disk Basic manual 
for info on what constitutes a legal filename . 

3) Memory Pull: This happens it you try to Append a tile which 
would exceed the capacity of the text buffer. As much of the 
file as possible is loaded, but probably not the whole file. 
Memory is now completely full. You can't type anything in 
until you delete some text. 

4) I/O ERROR: I/0 means Input/output Input is Reading in a 
file, output is Saving a file. So I/O refers to both: I/O 
means anything involving reading in or saving a file. 
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It the disk drive makes noi 
that could mean the di •- se and then you get an I/O Er 
t R d s~ette is bad th ror, 

o ea ls bad. Maybe th . • or e file you're tryin 
there's no disk in the drive directory's been destroyed o~ 
dislc or a disk that's had lt:· Maybe it's an untonnatted blanlc 
electro/ magnetic field. data destroyed by exposure to an 

If the drive inakes no no.ise and 
might =ean the drive isn't you get an l / O error, that 
switch), or .it isn't connected turned on (if it has a power 
spec ified a drive • higher. It could also mean you've 
(See paragraph 6, section J abo than ~Wilber of drives you have. 

ve on default drive".) 

5) wrWriitte protect error: You've tried to 
e protected u save to a di ~ 

isn't. . n-write-protect it , or us- s, that's 
~ a disk that 

L. I/O TO CASSErrE 

The Disk version of 
Retrieval of text files Telewriter-128 provides for Storage and 
this capability sim l on cassette as well as disk. To access 
Menu and the c~ett~ :..a~tMI (I/Oto cassette) in the (Disk) Hain 
~ Save an~ Read in Telewri~~~-1~;11 appear. Using this, you 

sk users liligbt still want t text files on cassette. Thus 
o read the next section. , 

To get back from the casset 

i
the I coznmand ("I/O to Disk;~ ~i~hMenu to the disk Hain menu use 
s not found in the Hai Me e cassette menu. This ~ 

n nu on a cassette only system. 

Beware: Once you go t 
keypresses will take y ~ the cassette Hain menu all tutur 
Disk Hain Menu as ~~n clc there. You should , return toe F2 
operation. Otherwise, a few a:in!~~·r~ through with the casse;~: 
Save that you expect to s own the road, you may do a 
spending several minutes list~~o disk, but instead find YQUrselt 
it tries to save your current tg~o~he cassette relay click, as 

~~i;o t:~et~i:1c~~i!::!u~asse~te sa!!e~~ ~~~~~e !n~ ~~ 
CASSErrE ACCESS 

A. READ IN PILE 

The "Re ad in f i le" 
casset t e i n to the text c ommand allows yo u t o Read 

buffer , where you can work a text file !rom 
o~ it with the 
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Edi tor. Since you've already read i n the Telewr1ter DEMO rile 
(Chapter II, section 13) we'll simply review the procedure in a 
l ittle more detail. 

With a tape in the recorder, position it so it's sitting just a 
little before the file you want to Read in (using the counter •s 
on the recorder and a written log of the files on the tape). Put 
the recorder on Play and hit R (Read In). A dialogue box will 
appear with the pro.a.pt "Enter tile to read in". At this point, 
just hit ENTER. The word •searching will appear in the dialogue 
box while the program searches for the next text file on the 
tape. When the file is found, the box will say "Reading in" with 
the name of the found file at the bottom. 

When it's done Reading in. you're returned to the Editor with the 
first page of the file on screen, in front of you. 

B. SAVE PILE 

To demonstrate saving a file to tape, take the Telewriter-128 tape 
out of the recorder, and put in a blanlr: one. Rewind to the 
beginning, reset the counter to ooo and fast .forward past any 
leader on the tape. Then press Record and Play down together. 

Go to the Hain Menu and hit s (tor save). A dialogue box will 
appear, waiting tor you to type in a filename. So type TESTPILE 
and hit ENTER. The tape will start and all the text in the buffer 
will be stored on the tape in a file called TESTFILE. (The 
filename you use can be no longer than 8 letters, and should give 
some information about its contents . ) 

During the Save, the word "saving• will flash in the dialogue box. 
When it's done, the recorder will stop, the dialogue box will be 
gone, and you' ll be back in the Hain Menu. 

C. APPEND FILE 

The Append command works essentially the same as Read In but, 
instead ot replacing what was already in the text buffer (as 
Read In does), the new file is appended or added onto the end ot 
what you have in the buffer already. 

To test this, rewind the tape you've just Saved TESTFILE on , and 
position it just before the start of that file. Put the recorder 
on Play and hit A (Append). A dialogue box will appear with the 
prompt: Enter file to Append. Hit ENTE..~ and the tape will start 
and the dialogue box will say "searching" . When it finds the next 
file on the tape (TESTFILE), the box will change to say 
"appending", and the filename TESTFILE will appear at the bottom. 
The co:'ltents of the tape file TESTFIL!:: will now be appended to the 
end of the current contents of your tex~ bu!ter . 
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When the file finishes Append~ng, the Editor screen will reappear, 
with the Cursor sitting at the beginning of the text that was just 
Appended. Behind the Cursor is all the text that was already ir. 
the buffer. You might want to cursor and page through the whole 
text now to see the difference made by Append. 

If the file you're Appending, plus the text already in the buffer, 
exceeds the space available in memory, Telewriter reads in as much 
as possible and then reports "Memory full" in a dialogue box. Hit 
any key and you'll be back in the Editor, but you must delete 
something before you can type anything in. See Chapter II, 
section 33 for more on the Memory full condition. 

D. ~SAVE 

~ (per cent) or "partial" Save allows you to save to cassette a 
part of what's in the text buffer. Before invoking this command 
you must first designate the chW\.k of text to be Saved. You do 
this by putting an End Harker (CTRL-E) at the end of it, and by 
moving the Cursor to the point where you want the Partial Save to 
begin. This is all done, of course, in the Editor. (Note: Use 
the Cursor to designate the start of the block to Save. Don't use 
the Begin Harker! ! ) 

Then, go to , the Hain Menu (by hitting F2), and hit~. A dialogue 
box appears and, from here on, everything works exactly like 
regular Save: you give a filename and hit ENTER and all the text 
in the Edi tor between the Cursor and the End Marker will be saved 
to cassette under that •n8Jlle. 

When you return to the Editor, after the Save, the End Harker will 
still be set. If you plan no more block operations on that chunk 
it's a good idea to delete the End Marker. ' 

E. VERIFY 

The Verify command Will read through the next text file on tape, 
til the end, but it will not read it into the text b~ter, and 
it won't effect anything already in memory. 

The Verify command is useful: 1) after a save, to make sure the 
file was properly saved without errors; 2) to find and display the 
next filename in case you get lost in the tape; and 3) to position 
you at the very end of a given file. 

To test out Verify, rewind the tape with TESTFILE on it, set the 
counter to 000, and put the recorder on Play. Hit v to invoke the 
Verify co:r.mand. The tape will start, the screen will go blank 
and a dialogue box will appear in the middle with the word 
"Searchir.g". 

When it hits the beginning of the next file on tape, the name of 
that file will appear in the box. As Verity reads through the 
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file, two lines of text will appear at 
changing with every click of the computer. 
completely scanned, the dialogue box will 
any key now to get back to the Main Menu. 

the top of the screen, 
Once the file has been 
say "PILE Okay!". Hit 

Should some kind of error occur, the tape will stop and the words 
"I/O ERROR"" will appear in the top border of the box. 

Hit any key to get back to the Main Menu. The I/0 error 11eans 
something i• wrong with the tape or with the data on the tape at 
that point. If the tile is not a Telewriter (ASCII) text file, 
you get the I/O error message at the very beginning (just after 
the name is reported in the box), but this does not mean that the 
data in that file is bad. 

If you get an I/O error when you try 
just Saved, then you should try to Save 
place on the tape or on another tape. 
and re-try the Verity on that same file 

1!. TAPE RAMDLING 

to Verity something you've 
it again at some other 
But first, rewind the tape 
again, just to be sure. 

Tape can be a little tricky to work with, sometimes, so, here are 
a few tips that will hopefully give you some control over it. 
we• 11 use Verify as the example, but everything we say about 
Verify will hold true for Read In and Append as well (unl~s 
stated otherwise). 

When you hit Verify, 3 things can happen (in the dialogue box): 

l) If you are currently going over blank tape, the word 
"searching" will appear. but not be flashing. 

2) If you have started the tape somewhere in the Diddle of a file 
(anywhere after the beginning of the file), then you are 
going over the stored data of that file, and the word 
"searching" will flash -- about every 3 seconds. 

3) When Verity finds the beg1nn1ng of a file, the word 
"Searching" goes away and the filename is displayed in the 
dialogue box. (For a Read in or Append, the word "reading" or 
"appending" also appears, flashing every 3 seconds.) 

Now, it, for some reason, you want to get O\•t of. a Verify (or a 
Read in or an Append) before it's done, -- you need to do 
different things, depending on which of the 3 states you're in: 

1) If the word "Searching" is flashing (about every 3 seconds), 
it's simply a matter of holding down the red BREAK Key tor one 
or two flashes of "searching". When you do that, the Verify 
will abort, the dialogue box will disappear. and you• 11 be back 
in the Hain Menu. 
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2) It a file has been found 
and the filename is i s~hthat the word "searching" is gone 
Verify command, then you ~im ~ d i alogue box, and you are in the 
key i n order to stop th P Y need to hold down the red BREAK 

e process -- j ust as in 1 above. 

~~iyh°::;ertoyo~t~pret~~ the midst ot a Read in or Append, 
hit h process before it run it the t e Stop button on the d s s course is to 
hit the Play button a 1ecor er. Wait a second, and then 
stopped), an I/O ERROR mega n. At that point (or maybe when 1t 
bo ssage will appe i x. Hit any key now and , ar n the dialogue 

' ' you re back in the Hain Menu. 
3 > If the word "Searching" i 

filename has not yet been fou!dthere and is not flashing (and a 
to do is make it flash It i), then the first thing you need 
going over any data - it.i ~not flashing because it is not 

s go g over essentially blank tape. 

So you need to stop the recorde 
tape to a point where you ~ and rewind or fast forward the 
necessary, put in another tow something is stored. If 
Telewriter text on it ape that you know has some 
so it'll be on a .ch~n, ~sition the tape in the recorder 
•searching" should start fl~i!ext, hit Play, and the word 
over data, not blank ta g (because now it's going 
technique of nWDber l above~)Hold~ce that happens, use the 
seconds. The box Will disa~pe down the BREAK key for 3-7 
Menu. ar an you'll be back in the Hain 

For the Save and % Save 
dialogue box, there's co111111ands, once you hit ENTER in the 
"saving" is flashing}. B~~. :~th!~ stop them (even when the word 
connected or not, the Save the cassette is on or not, or 
return to the MaJ.n Menu (the l will eventually rwi its course and 
the longer it will take) It'argjer the file you have in me1110ry 

G. CASSETTE ERRORS 
· 6 ust a matter of waiting. • 

An I/O Error (Input/output E 
Verify, usually !Deans that the t~ror) during a Read in, Append, or 
something was wrong when the filepe is bad at that point, or 
happens, you should back up to thew: ~aved originally. When this 
a~ain -- just in case. g nning of the file and try 

It you continue to get I / O error 
or the recorder You mi ht t • the problem is either the file 
other text tile~ from ot~e- t:st the recorder by trying to read in 
errors, the proble~ is probablpes. It you get a lot of I/O 
it out. Y YO\U' recorder and you should check 

:t the problem i s only in that one file 
ls los t. You can, however, retrieve all 
poin t of the error on the tape. 
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To do this, fill the text buffer with more text than is in the 
file with the error. It doesn't matter what you put in the 
buffer type in gibberish and do a bunch of block copies, or 
read in a file and maybe append a f- more -- just so 1110re space 
is talc.en up in the text buffer than is used by the file you're 
after. 

Now try to Read in the defective file. When you hit the I/O 
error, go to the Editor. Starting at the top of the text butter, 
you should see the begirming of the "bad" tile. Read through it 
and there'll coae a point where it stops and the gibberish you 
originally filled the buffer With Mill take over. Block delete 
from that point to the end, and you've -lvaged the first part of 
your damaged f 1 le, up to the I/O error. So now take thi• and 
re-save it someplace else. That's probably as good as you're 
gonna• do. 

• MAIM HBMO: CASSETTE AND DISlt 

The right coluan of comD&Ods and the bottOlll row of status 
in.formation are common to both the disk version and the cas-tte 
version of Telewriter-128. The commands are concerned with lllOVing 
you to the other parts of t .he system. 

A. <Fl> EDITOR 

The first. command in the right column says ' •<Fl> Editor•. 
means that hitting either the Pl function key or the E key 
get. you into -the Telewriter-128 Editor from the Hain Menu. 
that E and the Pl key will get you to the Editor frOll any 
menu in the systea.) 

B. <P2> FORMAT MENO 

Thie 
will 

(Note 
other 

Hitting the P2 function key in the Hain Menu will take you to the 
Print and Format Menu. Note that the P for ''format• is not 
capitalized in the menu. That means that P won't get you to the 
Print and format menu, only P2 will. (The Print and Poraat Menu 
will be discussed in Chapter IV. } 

Note that the !"2 key normally takes you the the Hain menu from 
an)'1'dlere else in the system. Only in the Hain menu, will P'2 take 
you to the Format Menu. What this means is that you can move 
quickly back and forth between the Main and the Format menu by 
just hitting F2. 

Also note that SHIFT-F2 will take you the the Print and Form.at 
menu from anywhere in the syste=. 

C. NEW DOCUMENT 

Hitting N (New document) in the Main Menu , takes you into the 
Editor just like E does, but .it also starts a "new document". That 
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is, it wipes out everything already in the text buffer and starts 
anew. Since it can be so destructive, it first puts up a dialogue 
box to znake sure you want to go ahead with it. If you hit y in 
response to the "are you sure" prompt, it will e111pty out the text 
buffer and put you into the Editor. If you respond with any other 
key,h.1.it'll silllply return to the Main menu without destroying 
anyt ng. 

D. OPTIONS 

Hitting O will take you to the Options Menu which will be 
discussed in Chapter VI. Note that SHIFT-Fl will get you to the 
Options menu from anywhere in the system. 

E. QUIT TELEWRITER 

Hitting Q in the Hain Menu takes you 
back to BASIC. Any text you have 
sure to Save anything you want 
Telewriter-128 will prompt you with 
a second chance to reconsider. 

out of Telewriter-128 and 
in memory will be lost, so be 
to keep, before quitting. 

an "Are You Sure", so you have 

P. TOTAL CHARS; PREE K1!M 

The bottom Hne .. of the Main Menu gives memory information: The 
number after Total Chars" ls the total number of characters in 
the text buffer; the number after "Free Hem" is the amount of 
space left in the buffer tor characters. On initialization this 
number is around 48000, indicating that 48000 characters c~ be 
typed into the buffer (approx. 24 typed pages). As text is added 
(t)lped in or Read in) Total Chars increases and Free Melll 
decreases. Free Hem cannot go below zero. When an insert would 
cause this to happen, a "Memory full" error message will appear on . 
the screen. Chapter II, Section 33 gives more information on the 
111e.mory full condition. 
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l FORMAT AND PRDIT MENU 

The Format and Print Menu allows you to eet up the final format of 
your document (margina, line spacing, etc.) and then print it. To 
get to the Format Menu fro• the Main Menu, hit the F2 Function 
key. (11le F2 key will move you back and forth between the Main 
menu and the Por-t -nu.). To get to the Format menu from the 
Editor, hit SHIFT-F2 or hit F2 'twice (the first hit gets you to 
the Main menu, the second to the Format menu.) 11lough its full 
name is "Format and Print menu", for brevity, we'll usually refe:
to it simply as the Format menu. 

2 PRDITDfG 

It's up to you to get your printer working properly with the Color 
Computer 3. But once you can do an LLIST or PRINT #-2 in BASIC on 
the Color Computer 3, and have it print out properly on your 
printer, then you're ready to print fro111 Telewriter. 

A nwnbe:- of different Print commands are found in the lower half 
of the Format menu. The 8th command down in the 1st column is the 
"Print document" command. So just hit P. now, and your printer 
(if it's properly set up) will Print out the contents ot the text 
buffer. 

While this happens, 2 numbers appear in the "Printing" dialogue 
box. After the words "printing #" the program displays the number 
of copies left to print (if you're not doing a multiple copy 
p:-int, this number will be l) . Below this, a second number 
indicates how many characters are left to print (if you're using a 
sizeable printer buffer, this is the number of characters left to 
send to the buffer.) 

If the printer is turned off 
online!" Error 111essage will appear 
key to get back to the menu, then 
? aga!n. 

or not on-line, a "?rinter not 
in the dialogue box. H!t a.~y 
put the pr!nter on-line ar.d h!t 

!f you've started a pr!nt, ar.d want to stop it now, hit the SREA.~ 
key. (Fo:- :nore information on "Aborting" a ?:-int like t!1is , see 
sect!o~ C below.) 
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A BAUD RATE 

It your printer or o 
parallel interface) ally ur printer interface (usually a serial to 
(and must) set Telewrit~l~ou to s e t BAUD rates, then you can 

er 8 to match that BAUD rate. 
The BAUD rate is th 
t e rate at whi h da o the printer The · c ta is sent from the 
printer (or int~rface)P;~~:~e~r~smits at a certain rate, c~~u~~~ 
rates must lllatch S a a certain rate and 
or interface is ~ino first determine the BAUD r~te your theintwo 

g at and then set Tel~it pr ter 
-"~ er to match it 

Not~ that if you can print from . 
you re running at 600 BAUD ~SIC without doing anyth• ... -
starts at and • l1lat s the rate the --v. then 
Telewriter~l28 the rate most Radio Shaclc Print Color Computer 
printer'• set f:;:sc~a:~.~t at 600 BAUD, 90 it =t~·~ for. 
If you do need to set BAUD rate )n Telewrit~ 

want to set BAUD t 
the right column of th ra e, look at the 6th COlllllland down 
ra;e> is the rate at which eTei~~ 111enu. XHIT RAl'.E (for transmJ~ 
pr nter (the BAUD rate). er tra.naza1ts characters to the 

So hit the x key and type 
box that flPPeare. To de~e appropriate number into the dial 
::~:r ~the cMt-t below. F~h~UD~! appropria1:e numbei: T, 
~~~i!;:~~~~t;e~to~n~~=r~~t~s ~::fEir·~~Thth~n~ 

ransmi t rate. · e menu 

printer l:>aud rate 

110 
120 
300 
600 

1200 
2400 
4800 
9600 

Xmit rate value 

, 498 
4S8 
180 
87 or 88 
41 
18 

6 
l 

;~~· tthoese8AtUDa BAUD rate of 9600, 
rate of the set Xmi t rate to 1 R be 

printer (or interface). progrlll!: must match the BAUD.ratee~mth~ 

B PARTIAL PRINT 

If you'd like 
pr.inted out, 
command. This 

to see onl y a small section of the 
you ca.~ do thi text butter 

follows t.h.e o . • s w!th the ~P~int or p · 
-rlr.t command in t.h.e artial Print 

Format menu. 
Before you d 

ca.~ o a partia' - ~ 
and designate the block ~ - P--nt, you must first go into E~ito_-.. - o_ text you w t '" 

a.'! pr 1!1 t ed. Do th.is by 
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firs t cursoring to the end of it and putting an End Harker there 
(CTRL-E). Then move the CUrsor to the beginning of the block and 
leave . it there. The CUrsor will mark the point where the program 
starts printing. Now hit F2 twice (or SHIFT-F2) to get to the 
Format menu. 

Hit the " key and the word "%printing" will appear in the dialogue 
box (along with the 2 numbers desc ribed in the preceding section) 
as the marked chunk of text in the buffer is printed out. 

Note that after a partial (%) print, the End Marker will still be 
set in the Editor. If you do not intend to do another block 
command on the same block (like another Partial print or a partial 
save), then you should delete the End Harker. 

C PRIMT ABORT 

If you need to stop the printout suddenly, at any point, you can 
do so by hitting the BREAK key (hold it down for a few seconds if 
the printing does not stop imuiediately) • . Eventually, the printing 
will stop, the dialogue box will disappear from the screen and 
you'll be back in the For111at menu. 

Note that if you ha~ a printer buffer either outside your 
printer, or in your printer, · then hitting BREAK will on.Jy stop the 
flow of data from Telewriter to the printer butter. The printer 
will continue printing until its buffer is empty. In this case, 
to stop the printing, you'll need to turn the printer off, or 
otherwise clear the print buffer. 

D VIEW PRINT 

You can waste a lot of paper trying to "get it right", so 
Telewriter-128 provides a View Print (or Pri.nt Preview) feature 
which allows you to see on-screen almost exactly tdlat the paper 
printout will look like. Left, Right, Top and Bottom margins, 
Line spacing, Page Breaks, Headers, Footers, Centering, 
Justif~cation, and Page numbering are all accurately shown-

So, hit V in the Format Menu (Vprint is the 7th collllll8.lld down in 
column 2) and, in place of the menu, the text now scrolls past you 
on the screen as it will appear on the printed page. 

You ca_~ stop it at any point, for closer examination, by hitting 
any key. To restart the scroll, hit any key again. To slow the 
rate at which the text scrolls by, hold down the S~I:t key. Let 
it go and the scroll continues at its normal speed. To abort the 
View Print, hit the BREAK key. 

Notice that the BREAK key jumps you back into the Editor instead 
of simply returning you to the Format menu. Also notice that the 
place in the text you've been returned t o in the Editor, is the 
same place in the text at which you hit the BREA.~ key in the Print 
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preview. That ~eans that whenever 
prevjew that you don't llke ( j you see somethjng ln the Prlnt 
just hjt BREAK Then, ln a s;l7td~c~~ orphan, line, for example), 
you need to be in the Editor to fi j d, you ll be right where x t. 

~~eyou don't hit BREAK, the text wlll 
printout and then stop with 

bottom ot the screen. At this.point 
you back to the Format menu. ' 

run its course to the end ot 
a reverse video "EOF" at the 
hitting any key will take 

bNote ~hat you can initiate a View print 
y h1tting CTRL-v. This makes without leaving the Editor 

quickly back and forth betwe th it even more efficient to go 
fix f en e Vlew Print and a t l any ormatting proble111S that c ua text to 
that. at the end of the screen int arise. The only difference is 
you'll be returned to the Edit pr out, if you don't BREAK out 

or, rather than the Format menu. • 
The use ot embedded control codes 
4H) can somewhat distort th (discussed in Chapter v. section 
Section 4J in the same h e appearance of the Print Preview. 

c apter, otters some solutions to this. 
11 PRINT: NUMBER OF COPIES 

The.#Print (NUJuber print) couimand allows 
copies of your document as 

0 
you to print as many 

#key, a dialogue box will ay u want, in one shot. If you hit the 
copies. Type in the desiP~ar, asking you tor the number of 
will then proceed exactly asr=i~~~r and hit ENTER. The program 
will reprint the document th e Print command, except it 
dialogue box that appears dur e numbe: of tjmes specified. The 
copies remaining to print. ing this, lndicates the number of 

F • PRINT: PRINT TO DISK 

The •Print command in the Fo 
file to disk. This me~ th!~~~nu lets you "Print" the current 
go to the printer now acter for character, what would 
formatted file, with.all ~~esstoca di~k file -- i.e. a perfectly 
justification, with headers :a es lnserted for margins and 
approp~iate places on each page. page numbers printed at the 

Hit asterisk (•) and the di 1 "Enter name of file to spoo~ ~e box that appears will ask you to 
and hit .,..,.,,ED 0 . Type in a legal RS DOS f · 1 . ...,,. ~ and the formatted file will be l enair.~ 
you provide no extensjon a SPL t . saved to disk. I~ 
filename. ' · ex ension will be added to the 

This command will only be use' 
p~ograrn that needs t~ access ~u; to you if you have some otrer 
~n which all t'-e "e-bedd d ormatted text tile -- i.e . a fi!e " ... e commands" ( .., · · -
been replaced by their final - l see c .. apter V below) have 
!or example, would probably pref~~ut~7 · A communications progra~. 
c:nbeddec formattjnn ~nd c t- l - .. 1s type of file to one with ,,, - on .o_ codes. 
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There are several key factors involved in determining the final 
appearance (or "format") of your printed document. These factors. 
or "format parameters" include: Top margin, Bottom margin, right 
Margin, Characters per line, line Spacing, Lines per page, right 
Justification, page Numbering, and page nWllber position. 

The format parameters occupy the upper half of the For111at menu, 
and each is followed by a number, or the word ON or OFF. These 
numbers are the current values of the format parameters. Hhen you 
first run the program, you will see the preset or "Default" 
values. To change these values at any time, simply hit the first 
(capitalized) letter ot the parameter, and type a new value into 
the dialogue box, followed by ENTER. The new value tilen appears 
in the menu, · beside the parameter. 

Note that values set in the Format menu cover the entire 
printout. If you wish to change margins, . spacing, etc., during 
printing, you need to use Embedded Format Comiands. These will be 
described in the next chapter. Now, we'll go through the Format 
parameters as they appear in the Format menu. 

A SPACING 

To set line Spacing, hit S and type in a number followed by 
ENTER. For single spacing, type in 1; for double spacing, type in 
2. • Though you can set Spacing to any nW!lber up1:o 127, for most 
normal documents, 1 and 2 will be the only numbers you'll use. 
This value is initially set to l by the program. Also note that a 
value of 0 will cause single spacing. 

B MARGIN 

To set the left Margin, hit M, type in a number and hit E.'ffER. 
When you first run the program, left Margin is already set to 8 
(the "default"). This means the printer will do 8 spaces at the 
beginning of each line. 

You can set Margin to any number from O to 127, but on an 
80-coluum printer, a value of only 40 would cause each line to 
start half way across the page. Though there are times when you 
might want to do just that, standard left Margins are generally 
be~ween 5 and 12 spaces wide. 

C CHARS/LINE 

~itting c (Chars/Line) in the Format Men~ is the sa11:e as hitting 
CTRL-@ in the Editor. It puts up a dialogue box that allows you 
to set Characters Per Line. This number, co~bined with the left 
!'\argin value just described, determines what the Right Margin will 
be for the printed document. 
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To figure the right margin (if you need, or want to do so), add 
the (left) Margin value to the Chars/Line value, a.~d (since most 
printers print BO columns wide), subtract that from 80. 

So, if Margin is set to 8, and Chars/line is set to 63, then: 
8 +63 = 71, and 80 - 71 a 9. Thus, the right margin will be 9 
spaces wide, and, it the paper is properly aligned in the printer, 
the docment using these settings (Margin=8, Chars/Line=63) should 
print centered on t .he page. (Proper alignment means that when 
Margin is set to 0, the printer will start printing at the left 
edge ot the paper - just after the perforation.) 

Note that if you're using an 80 column printer (which, odds 
you are), the sum of Margin+ Chars/Line should never exceed 
1t this happens, you will see "printer overflow lines" (lines 
break oft at the right edge ot th~ paper or wrap around the 
margin causing extra blank lines) , and top and bottom margins 
come in the wrong places. 

are, 
79. 

that 
lett 
will 

(The exceptions to this "less than 80" rule are: wide carriage 
printers with 132 columns, condensed print (usually providing 132 
columns), and proportionally spaced print, which often squeezes 85 
or .90 characters into 64 columns of mono-spaced print.) 

Note that when you set Chars/Line in the Format menu, the text 
currently in the buffer will be aligned to this new value at the 
same time -- just as if you'd set Chars/Line in the Editor or hit 
CTRL-A there. Since you don't see t he text when you set this 
value from the Format menu, don't be confused if you return to the 
Editor and notice some changes in alignment. 

D OPPER/.BOTTCfo! MARGINS 

Upper Margin sets the number of blank lines the printer will leave 
at the top of each page before it prints the text. Bottom Margin 
sets the n\llllber of blank lines the printer leaves at the bottom of 
each page, before the perforation that separates the pages. · 

Telewriter-128 initializes both these values to 5. You can set 
them to any n\llllber upto 127, but numbers greater tha.~ 10 don't 
make much sense since there are only 66 lines on a page. 

To set Upper Margin, hit U and type in the new value, followed by 
ENTER. To set Bottom Margin. hit B a.~d type in the new value 
followed by ENTER. 

E LINES PER PAGE 

For standard 6 1/2 X ll printer paper and standard line space 
width of 1/6 inch . Lir.es per pase should always be set to 66. 
Since it's initialized to that value by the program, you generally 
don't have to set it. 
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If, for some reason, you do want to set it, hit L, type in the new 
value and hit ENTER. (It you're using non-standard size paper or 
a 11Pe-space width other than 1/6 inch, then you'll have to 
deteraine the number of lines per page yourself by counting the ' 
of line feeds it takes to span the full page.) 

Please note : To do double and triple spacing you DO NOT change the 
value of Lines per Page. Changing the value of Spacing takes care 
of everything. 

The •ffumber pages" parameter determines whether pages will be 
automatically mmbered during printout. It it'• -t to zero. then 
pages will not be numbered. It it's set to any number other than 
zero, then pagee will be numbered consecutively, beginning te.ith 
that nuaber. Though 1 is probably the -t popular value for this 
parameter, you can set it as high as 32700. 

The page number is always printed 3 lines up from the bottom of 
the page. For this reason, it you want pages nwabered in this 
fashion, Bottom Margin!!!!:!:!! be set to a value of 3 or greatv . 

Note: For the page breaks to come tlhere you ..ant them (i.e. before 
and after the perforation of the computer paper), it's important 
th.at you start printing with the paper set at just the right 
point - with the print-head of the printer 80M\lihere at, or 
slightly above, the top of page. 

You can quickly work this out by trial and error by setting Upper 
Margin (0) to o and doing a print (P) and th.en abort (BREAK) after 
a line or 2 baa printed . If the top line of text is on the very 
tirst available line atter the perforation, then uae this position 
every time you start a print. 

To -t the Nwlber pages parameter, hit M, type in the desired 
starting page number (or zero) and hit ENTER . 

G WHERE PAGE NUH8ER POSITION 

The Where value determines where the page number will be 
positioned on its line . To center it, for example, take one ha!! 
the Chars/Line, add the Lef~ Margin value, and set WSERE to that. 
So, if Margin• B, and Chars/Line • 63, then set WHERE to 39 {63/2 
+ 8 ). To set the value of this para.meter, bit w. type in the 
desired value and

0

hit ENTER. The new value will appear beside it. 

The page numbering method just discussed is the "c;uick a.~d dirty" 
kind: easy to do, but not a lot of contr ol. !n Chapter V, 
sect ions 4 E-G we' 11 show you how to put page numbers a."lywhere, o:-: 
any line , at the top and/or bottom of the page. 
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H RIG~T JUSTIFICATION; NON-BREAKABLE SPACE 

The Justify command in the Format m 
from the others. It has only 2 l enu, works a little differently 
text will be right justifie~ ues, ON or OFF. It it is ON, 
document will be printed with on printout. If it is OFF your 

a ragged right edge. ' 

To change the value ot Justify hit 
it• the value changes to its o~ it the J key . Each time you hit 
hit J and it gets set to ON Hi~ e . It Justify is set to OFF 
OFF. (This is often referred.to as J .. again an~ it gets set back t~ 
Because there are only 2 l toggling back and forth) 
efficient way to set it th vai ues involved here, this is a mor~ 

an us ng a dialogue box. 

Note that when text is right just! 
in the printout to fill out the 1 ~ied, the program inserts spaces 
there are already spaces. But ther:s. It does this only where 
additional spaces inserted betwee are times when you don't want 
from happening, and to kee c:rcertain words. To prevent this 
(Le. not broken up at a p in tain word combinations together 
character is provided. marg ), the "Non-breakable" space 

Hitting ALT-SPACEBAR in th 
in the text at the Cur e Editor generates a non-breakable space 
Left arrow, ~tit will P;~~tposition. On screen, it appears as a 
words (or 2 nwnbers or a wor as a space. It it falls between 2 
be split up by alignment d and a number), these words will not 
inserted BETWEEN theM d in' and additional spaces will not be 

ur g justification. 

At this point, it might be a 
parameters come t good idea to see how all these 
the paper in the p~~:;r(~ ~he printing of a document. So align 
values we've just di escribed above) a."ld set all the 
Justification to l, and Bo~=s~ Set page nwnbering to l, 
let the printing run its course gin to ' · Now hit P (Print) and 
numbering, and justification. so you can see page breaks, page 

I ONE PAGE 

It you use single sheets of 
computer paper, you will paper rather than continuous fan-fold 
parameter, like Jusif want to set One Page to ON. This 
page) and the value c~ has only 2 values, ON and OFF. Hit 0 (One 

ges to its opposite. 

During printout, it One Page is set to ON 
pause at the very bottom of each • • the printer will 
appear, waiting for some input t~ page, and a dialogue box will 
fresh sheet of paper, restart .om y~~· Once you've inserted a 
ca~cel the rest of the i t.~e P--ntout by hitting ENTPR To 
th t ·t pr nt ru.n at this tim hi · - · .a 1 you have a sizeable rint ,, ~ e, · t BREAK. (Note 
appear lo~g before the p~• t ~ er bu._er, the dialogue boY. wil! 

--r. e. actually pauses.) 

O~e page a!so wo~ks t~is way f 
o~ View Print, w_o_~·.·~ .. t J ano..: •Pri~t. 
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J AUTO-LP/EPSON 

The Auto-LF/Epson parameter can be set to l of 7 values (O through 
6), but only 3 are really relevant: 

l) For Host Printers, Auto-LP/Epson should be left at O and 
forgotten about. 

2) A setting 
character to 
(along with 
mark the end 

of 5 means that Telewriter will send a Line Feed 
the printer at the end ot every printed line 
the Carriage Return character it always sends to 

ot each line ) . What that -ans is this: 

Host printers automatically supply a Line Feed whenever the 
computer sends them a Carriage Return. Otten, there is a •dip 
switch" so the user can set whether this will happen or not. 
We recOU11Dend that if your printer is set this way, you leave 
it, and, if it isn't, that you set it to supply an Auto 
Linefeed. Once you do that, you can leave Auto-LP set to O. 

It, · however, when you pr int, you get only one line on the page 
which prints over and over itself, and if you can find no way 
to set your printer to provide an Auto Linefeed, then simply 
set Auto-LP/Epson to 5 and t:ry Printing again .(&ame Daisy 
wheels and older printers seem to require this), 

3) It you get normal printing, but no Opper and Bottom margins, 
then try setting Auto-LP/Epson to 4 and printing agilin (old 
Okidata printers sometimes needed this). 

4) The l and 2 settings were used in the original Telewriter 1.0 
to specify the use of an EpSOll HX-80 (the original Epson) • 
These settings are maintained for coamiand ·compatibility for 
early owners ot the oris;rinal Telewriter. At this point in 
history, however, they are fairly irrelevant and any Epsan 
printer should be handled just lilce any other printer, with 
Auto-LF/Epson "set to O (ox: 5) 

K DIRECT CODES 

Most printers use what are known as "Printer Control Codes'' to 
provide access to different fonts, modes, and print qualities 
(italics, boldface, etc.). The "Direct codes" command (D), lets 
you send these codes Directly to the printer from the Format menu. 

Though different printers usually use entirely different codes 
from each other, here's a quick demonstration that any printer can 
use. Hit D. and type the number 10 into the dialogue box appears. 
Now, when you hit ENTER, YOU!" p~!nter should do a line feed. Type 
!n 12 and hit ENT~R. and it should do a tor~ feed. 
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PRINT AHO FORMAT MENU 

Notice that the dialogue box stays around even atte~ you type in a 
nWDber and hit ENTER. This allows you to type in a sequence ot 
control codes. Remember you must give one value at a time 
followed by ENTER. For exaniple, if the printer wants the codes 27 
Bl to do boldface, then type in 27, hit ENTER and then type in Bl 
and hit ENTER. To get out of Direct code mode and back to the Format menu, hit the BREAK key. 

The number you type in can range from o to 255, and its effect 
W.111 depend on your printer. Consult your printer manual for a 
list of its control codes. Make sure you use Decimal values for 
Telewriter ~ not hexadecimal or alphabetic, as listed in some printer control code tables. 

The last command in the right column is "Typewriter". This is a 
m.inor feature Which allaws vou to - type in a line and have it 
immediately printed by the printer. 

When you hit T, the Ponoat menu will be replaced by a nearly blank 
·· screen which says "l'ypewriter--Press <BREAK> when done", at th~ 
·· top. You can simply type now, and Whatever you type will be 

~· prioted out as soon as You hit ENTER. · After that, vou will stay 
·· ·· in the same screen, and the Cursor will mov-e down to the next line 

so You can keep typing lines one after the other. When You're 
through, just hit BREAK and vou'll be returned to the Format menu. 

A line can be lllOdif.ie.d at any Point before You hit ENTER, but the 
only editing control you have is the"Left Arrow key, which deletes 
the previous character and backs the Cursor up one. 

There is, of course, no Wordwrap in Typewriter mode, and none of 
the values set in the Fonoat 111enu Will have any ettect on the line 
printed out. So, if you want a left margin, for example, You will 
have to supply it yourself by hitting the SPACEBAR a nwnber of times. 

H FONT 

The 6th command down in the left column is the Pont command. This 
is another command leftover from the early Telewriter 1.0, and 
maintained here for compatibility with early users. It should be left at o. 
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CED FORMATTING AND PRINTING V. ADVAN 

EMBEDDED PO.nnn . .,...T COMolANDS· OVERVIEW 

hold for the entire Format parameters set in the Forma~ :e~~re the Jllal'gin will be 8 
d cument If you set Margin 1~ But ~here are times when 0 

• f page l to page · f t parameters at spaces wide, rom h values of certain orma need to change t e 
x~~ferent places in the text. 

To handle these 
Pomt c,._ands. 
in the text -
set in the Format 

it -l28 provides Embedded situations, Telewr ~t are actually placed 
These are commands effect as parameters yet they can have the suie 

menu. 

inside the body of commands, since they do occur rmal text For 
Embedded Format to be distinguised from no th; text 
the document, n~= ~a:!i symbol c-> is us:d·~ ~~::"i~ is not 

~~ ~=1th a Caret ;: ~~ed ,:" c::.:. the val~ ~ ~.!.,'). Prin_ted. Instead, it form other dynamic tasks 1n 
ters {or to per 

format parame 11 the 
ds to set almost a Embedded Format Comman These include: =am~:rs~~t yo~~=~li~~. ~~:e/=:1n,~~s per page, Bottom 

Spacing, Margin, i and .Justification. margin, page Number ng 

EMBEDDED FORMAT COHHANDS: EXAMPLE 

is common practise to set off articles and papers, it des so let's assume ~~ngwr~!~~: by indenting them ~n ~t~ous!udd~nly come to a 3-line 
you're working on add~~s.fashJ.on during printout. 
quote you want indente ft Margin of 8 and a right 

that your document has a lehieve the desired results, 
Assuming {Chars/Line=64), then, to ac d the right margin to ~?~"~,

8

,0 change the left ~tn3to1:::.."'.' (See chapter !::.; r. (Ch~o/11""•48) f~r l::S!.th~o ~n~rt between ri~ ~h ~ 
section 3C for the s m~d indent them a little less t 
Chars/line). Th~s ~~ the current margins. 
each side, relat ve an embedded format 

in Telewriter using to change Margin to to get the printout 
You can be accomplish this 
command. In this case, 
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16 and Chars/line to 48 when it gets to the quote, we'd immedi
ately precede the quote with this embedded format command line: 

When the printout comes to this point in the document, the Caret 
(") tells it not to print this line. but, instead. to execute the 
commands in it. The first command is M16, which causes the Margin 
(M) to be changed to 16. The second coavnand on the line. C48, 
changes Chars/Line (C) to 48. 

Then, after the quote has printed, since Margin and Chars/Line are 
still set to 14 and 48 respectively, we need to return to the 
original settings (Margina8, Chars/Line•64) for the remainder of 
the document. To do this, we follow the quote i1TIJ11ediately with: 

Here's a fragment of a political article, showing how this would 
look on-screen: 

This point was probably best made 1n the Senator's opmtlng 
~emarlcs. when he said: 

-M16 C48 
Blah blah, blah blah, blah blah blab blah, blah blah ••. uhhh 
and further, blah blah blah blah blab blab blah. And don't 
overlook, uhhh, blab blab ••. 
-Ma C64 

Of course, several members of the Senator ' s CMll party were 
quick to voice their total opposition to this concept. 

Then, when this is printed, it'll look approximately like this: 

This point was probably best made in the senator's opening 
remarks, when he said: 

Blah blah, blab blah, blah blah blah blah, 
blah blah . .. uhhh and further, blah blah 
blah blab blah, blab blah. And don't 
overlook, uhhh, blab blah .•. 

Of course, several members of the Senator's CMn party were 
quick to voice their total opposition to this concept. 

3 EMBEDDED FORMAT COMMANDS: RULES 

a. Since there is no Caret symbol (") on the Color Computer 
keyboard. Telewriter uses a CTRL-key combination for it. To 
type the Caret symbol. hit CTRL- period (CTRL-.). A Caret(") 
will appear on the screen at the CUrsor. This is the character 
you need at the beginning of all embedded format command lines. 
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111\lSt be on their own line 
that 

b. Embedded format con:mands line as regular text. 
is •. not mixed on the same 

be changed (and the letter codes 
The format parameters that can d line) are: 

c. that stand for them in the cosnman 

M "" left Margin 
u = Upper margin 
N .. Number pages 

s spacing 
s = Bottom margin 
J Justify 

c .. Chars/line 
L .. Lines/page 

t and for the in the co111111and line to s 
Note that the letter use:ame as the key you would hit in the 
parameter is exactly the 1 f tbat parameter. 
Format menu to set the va ue o 

an embedded couunand, silllply 
format parameter not set by t inenu so you only need 

d. :~s the value already set in ~tF~~~hange.' A new value will 
to specify the parame~~~o~orinat command changes it. 
hold until enother e -

begins with a caret ( l, 
Erobedded format command line always commands. Each format 

e. An followed by one or more format anieter to be 
which is f a letter representing the par which will 
command consists o L or N) end a number, 4 chenged (M, C, S, U, ~,JJ,which is discussed 1n section • 
be the new value (excep • 
below). 

be followed iJlllDediatelY by the 
The parameter letter 111\lSt l No space should separate the 
number indicating the neK va ue. when JDOre than one Format 
letter from the number. Howevert;._, must be separated by one or 

i t on a line, ·-• -coJ)ll!laild s pu 8 command like: 
more spaces. Thus. 

-M12 C66 52 B5 05 
chars/line to 66, spacing to 

will change the left Margin~~~ to 5, and Upper margin tot~ 
dallble-spac1ng ( 2) • Bottom and its value are not separa 

i that the parameter separated by a 
Note aga n, that different commands are 
(as in M12), and 
space (as in 52 B5 05). 

. e same line as shown above. or 
The coumiands can all be put on ~ate line. (In this case, each 

f. they may each be put on a sel Thus the four lines below have 
t begin with a caret. , 

line mus -~-- effect as the one line above: 
the exact .....-

"Ml2 
·cs6 
·s2 
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g. There must never be more than l caret 1n a single embedded 
command line - and the only place that caret is allowed is at 
the beginning of the 11ne. 

h. An embedded command line should never exceed one line on the 
screen, though any number of lines can follow one another as 
shown in t. above. 

i. Alignment will have no effect on embedded command lines, and 
will not combine them with other lines. 

j. Wordwrap will have no effect on embedded command lines, and 
they will not be broken if you exceed the right margin while 
you type them in. If they exceed the right edge of the screen, 
they will simply wrap around onto the next scree11 i!:-.. . 
creating a continuation line. Though you can break them 
yourself by hitting ENTER at any point in the line, you should 
never do so (the fragmented part won't work properly, it at 
all). 

Note that these same circumstances regarding wordwrap will also 
hold if you accidentally (or even intentionally) place a caret 
in a normal line of text. 

k. The command letters can be either Upper Case or Lower, but 
Upper is recommended because it stands out better. 

1. If an embedded command line actually prints out (on your 
printer or during a print preview), that means you have ma.de a 
syntax error in the line. Examples of possible syntax errors 
would include: Separating a command letter from its number by a 
space ( " M 10): Using a non-existent command letter ( "KlO): or 
including another caret symbol on the command line ("MlO "C64). 

m. The embedded format commands just discussed only take effect 
during printout. However, after a Print or print preview, any 
changes in Chars/line will still be present in the text when 
you return to the Editor. The 4 line quote above, for example, 
would still be only 4 8 characters wide. However, hitting 
CTRL-A would instantly realign it to the current setting of 
Chars/Line (64 in this case). 

n. Avoid having any extraneous spaces at the end of an embedded 
command line. 

o. Changing the Bottom margin does not take effect until the next 
page after the command is given. In general, Lines per page 
should not be changed unless you know exactly what you want to 
do. 
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4 OTHER EHSEDDED COM'WfOS 

Besides being used to indicate 
the Caret serves to designate other 
be placed .!!l the text. 

Embedded Format Command lines, 
special c~s that need to 

are involved in such functions as: 
These other embedded commands t Centering Forcing New Pages 
Protecting blocks from Ali~i~ter Control' Code Definitions, 
(form feeds). Headers, Footers, Tab stops and marking non-printing 
Disk Chain Printing. Setting • 
"comment" lines. 

" ther" embedded command lines 
Unless otherwise indicated, these o f mbedded "format" 
follow the exact same rules spec1f 1ed aboVe or e 
command lines. 

discussed below cannot be combined 
Note that most of the commands 1th the 8 eabedded format 
on the same line with each ~th:~s~~i~d above. Some even deal 
commands (M, c, s, U, B, :J, ~· ) hanging format parallli!lters. They 
with functions far removed ro~ c " taclcsM of embedded command 
can. however• be placed freeily :Jn bel'::,,. for more on •stacks"). 
lines in .the text (see sect on 

A ALIGNMENT PRQTECTlON 
• , -· 

In Chapter . II, you saw 
together all . short lines 
indented. 

hOW 
not 

the CTRL-A (Align) command pulls 
separated by a blank line or 

~~t short lines left But sometimes you .. -. f 11 t 
command. This is especially true o s s 

best for1113tted by hand. things that are mmand 
Telewrlter provides the embedded co 

alone by the Align 
and columns and other 

For this purpose, 

as "the non-align code"). This 
(Caret-semi-colon), also Jcnown l d around a block of text, will 

mbedded mmand line• p ace 
s1mpleteal1gnmen~ofrom operating on that block. 
preven . 

l
e type in the list from Chapter II . section 9,1~~ 

As an examp • od 50 the screen looks 
surround it with the non-align c e, 
this: 

. 
i carrots 
2 Apples 
3 Oranges 
4 Artichoke 
5 cauliflower 
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Now hjt CTRL-A and notice that two non-align code lines (- · the list isn't aligned. Delete the 
list will be combined into ill~~ ~it CTRL-A again. This time the y the alignment routine 

Not h . e t at the non-align cod ~~e protects everything that f~~l~=ti~efused in pairs. The first 
e second one allows eve thin rom being aligned and 

properly aligned again. Th~ ifg after the protected block' to be 
remainder of the text will go'una.11the~e is no second one, the gne when you hit CTRL-A. 

Should you have fragmented an text, even after hittin d/or overflow lines in your on scree 
likely cause of this will ~~~A or setting Chars/line, the mos~ 
somewhere preceding the fragmen~e~gtle (unbalanced) non-align code ext in the buffer 

The non align command (- l · ~~n~h It should not be; co~~~!~ :!;~ys be the only thing on its 
e same line, either precedin°g or fanlyl other embedded commands o owing it. 

During printout, the non-all being right justified (if Just~i~~~ also prevents its block from 

An 

on is set to ON at the time). 

embedded f ormat command to ~~=r ~put inside a block that isc~ge Chars/line (-c) should 
( ;). This would force an ali rounded by the non-align 

very text you're trying to gnment to occur on some of th 
prevent all protect from ali e 
nond-align co~~~\~~o~~;fec~;~gi1the1 text that ~~ t:d se~~: 
an -H• co d · ar y, the -MD -M -mman s (discussed bel l ' +, M- -M= ~~=/li~ block, because part of th~r ~~ild niever go i~lde ~ e. on ncludes resetting 

B CENTERING 

To have a lin with -• e centered automaticall (on the same line) Thi 1 y on printout, simply begin It 
~~ each individual screen.li s s done on a line by line basis ne you want to center.must be gin with 

For example, a heading 

-·Arthur Rimbaud 

that looked like this on the screen: 

- • 70 Market St 
- •venlce, CA 9 2116 

would print out as 

Arthur Rimbaud 
70 Hark.et St 

Venice, CA 92116 

Note that t.~is centerin 
double- width o~ condensec g command will not characters are used. 
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centered by hand (counting characters and using spaces to center 

the line). 

C NEW PAGE I NEW PAGE NUMBER 
There are times, in the midst of printing a document, when you 
need to suddenly start a new page (like going to a new chapter, 
printing several different docwnents in the same text buffer, or 
forcing a new page to eliminate widcM and orphan lines). The -N 
command. placed anywhere in the text (on a line by itself), will 
cause the printer to jump to a new page when it is encountered 
during printout. It will then space down for the Upper Margin as 
currently set, and continue printing with the line right after the 

-N in the text buffer. 
If the " N is followed immediately by a number, it will start page 
numbering using that number. For example, the embedded command 
"NlO will jump to a new page, and start page numbering at 10 

when it gets to the bottom of that page. 

You can also use the -N command followed by an equal sign and a 
number, to set a new page number without forcing a new page. For 
example, ·N•10 will cause the current page to be numbered 10 
when the bottom is reached. Page numbering will continue 
sequentially from there, unless another -N• is encountered. The 
command "N•O is somewhat special. Like setting "Number pages" to 
zero in the Format menu, it turns automatic page numbering oft. 

Normally. when a document finishes printing. it will automatically 
advance to the bottom of the last page (and print the page number 
if page numbering is on). If you wish to prevent this, use the 
-sx embedded command. This conmiand says, essentially. "Don't 
advance to the bottom of the last page when done.• If, hoWeVer, 
auto page numbering is on, the -sx will be overridden and the 
document will go to the bottom of the last page anyway. in order 
to print the final page number. To avoid this, use the line: 

This turns off page numbering so the ·ax won't be overriden. 

D SET.rING TAB STOPS: DEFINITION LINES 

So far you've seen embedded comr:iand lines used exclusively to 
"coramand" the printout to take cer~ain actions: "Change the left 
111argin to 8!" "Start a new page!" or "Center this line!" 

But another important use of the embedded command line structure 
is as a "definition line". A definition line ls an embedded 
command line that "sets something up", but doesn't have an 
immediate effect when it is encountered. The simplest example of 
a definition line in Telewriter, is ~he embedded line that's used 

to set tab stops. 
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So, to do just that, jump to the top of text with CTRL-Up 
and hit ENTER to push the top line down a line, Then 
Arrow, so the Cursor is now back at the top of text. This 
only place the tab stop def!nition line can go. (Most 
other types of definition lines can go anywhere.) 

Arrow 
hit Up 
is the 
of the 

Now type Caret-T ( ' T), followed by a space. Now, simply type in 
the screen column numbers where you want the Tab stops to be set. 
Each nWllber must be exactly 2 digits and each 2-digit number must 
be separated by a space. So, to set tabs at columns 5, 9, 20, 30, 
38, and 45, you'd put the following Tab definition line at the 
very top of text. 

• T 05 09 20 30 38 45 

To determine the column numbers .you want for your tab stops, 
simply cursor over to those points on the screen and hit CTRL-I at 
each one. The first "Info window" will appear, and the first 
number in it ("At column:") tells you what column you're at. 
Subtract l from this number, and use the resiilt in the Tab 
definition line. (This is a lot easier than manually counting 
characters but if you do count manually, remember to still 
subtract l to get the actual number to use.) 

Since there's no Tab key on the Color Computer, Telewriter uses 
CTRL-ENTER for this purpose. (Hold down CTRL and hit ENTER.) If 
there is no Tab definition line in a document, hitting CTRL-ENTER 
will tab over to column 5, and that's all. 

Once you've put a tab stop definition line at the top of text, 
hitting CTRL-ENTER anywhere in the text will tab you over to the 
next tab stop on the current text line, as defined in the Tab stop 
definition line. 

If you hit CTRL-ENTER on a blank line, it will insert spaces in 
the text until it gets to the next tab stop. If there's text on 
the line, the tab key will simply move the CUrsor to the next tab 
stop on that line. If the next tab stop lies beyond the end of 
the text on that line, then the cursor will move to the last 
character on the line (including space and CR) and insert spaces 
beyond that point, u.nt_il it gets to the next tab stop. 

You should be aware, then, that invisible spaces can be left lying 
around unnoticed as a result of tabbing someplace and then not 
putting anything there. Wherever possible, you should delete 
these extraneous spaces, as they can sometimes cause confusion in 
the editing process. 

Also remember that a tab defir.ition line, placed anywhere except 
the absolute top of text, will not set tab stops. 
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h pane beginning 
int at the top of eac ~ 

To cause a header to P~ flnition line" like this: 

with 

P
age 2, use a "header e 

EMBEDDED CQtol4AMD:S. 
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bedded command lines, 
1 line like all other emdefinition must also 

A header def ini t on 'B t th Header k 
be i with a caret. u eof the line, in order to wor 

must g n c·i at the end 
have a caret 
properly . 

b the letter H (for Header), 
i caret is followed Y his value sets the 

!~~ch~:
1

~1nbl~lank i~~;at:~ic~yw~l~~~~ateTeach~~de~0~~~ ~~= number of inted page· A space owed at 
actual body of text on the pr l text of the header, foll • 

and then comes the actua 
nwnber nd by the second caret . 
the very e • e above would 

exain le header definition lin d c~me the 
During printout, the at ~he top of each page, woul ·u embedded 
work like this; First~ in the Format menu or with ~TER-128 
Upper Margin (as se the header itself (T llowed by 3 
fonnat comm.and). Then COMMANDS) would print, fo 

EMBEDDED i for that page. ··············tli· the actual text would beg n 
linefeeds and en t the very top of text . 

i line should occur a ab line should 
The hea~:~ t!~~i~i;~nstop definiti~~ li~,t~~H!ader definition . 
If you a followed on the next ne he header definition as 
go . first, d lines can precede t f text between 
other embedded comman blank lines or lines 0 
well, as long as there are no 

them. blank lines anywhere 
one or more lines of text or of text, then the 

If ther~he~=ader definition and hthe ~~r!h~~~d (on page 3 instead 
between ll ~in a page later t an 
Header wi ...... ,.. 
of page 2). 

ot be effected by the current 
When the Header is printed, itt~~ili~s positioning explicitly with 

in -- so you must con 
left ~~ its definition line. 
spaces lin Like all 

should be kept on a single e~u exceed the 
The header definitioni it will not wordWrap when yed e of the 

bedd d command l nes, the right g 
em e in but will continue out to width it will simply 
right marg1t' it e.xceeds the 80 column screen continuation line). 
screen. d onto the next screen line (as ~ lines, it will not be 
wra~ aro~ke all the other embedded c(~~A) or by setting or 
Agan, . h Alirm~ent command 
effected by t e ,.,--·· 
re-setting Chars/line. 

h ENTER anywhere inside :~ned 
l as you don't ··1 t The Header -

Therefore, as ong will not get broken up. • 
Header definition line, it 
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f!HB!mo.en COMMANDS 

Footer definition lines are th 
Editor where an overflow li e only situations in the Telewriter 

ne is preferred to a wordwrapped line. 
It is also a good idea to k 
the first line o! actuale~~x~e~der definitions separate trom 
line. It this is not done d n the buffer by at least 1 blank 
broken by hitting ENTER i~ t~ 1i the header definition line is 
first line of te>rt may be i ne, as described above then the 

mproperly aligned. • 

-- Header Page Nunibering 

The total number of characters in the 
Header cannot exceed 255. 

If you put a backslash character 
then, When the actual heade i (\) in a header definition line 
the backslash in the de~in~t~rinted at the top of each page' 
2rinted header by the c on line, will be replaced in th' urrent pag~ number. e 

The backslash character is produced 
key down and hit the slash {/) k ) by hitting ALT-/ (bold the ALT 
~ ~alder definition, the bac;!l~sb Whe7ll used anyWhere outside 
ac ash. w Silllply print as a 

Using this header defintion line: 

·a3 l'ELEWRITER-128 

produces a header that l 
ooks like this, at the top of page 10: 

TRLEWRITER-12e 
page 10 

The starting page number for the d 
Number pages parameter in the F ocument .is still set with the . 
format command ( -N~) N ormat menu or with an embedd d 
printing from the begi~ingo~all~, you will set it to l if you';e 
given, this would cause the t~ ocwnent. In the exaDiple just 
~t page .. 2), to say "page 2". Su~=t header that prints (at the top 
page 4 , etc. equent pages will say "page 3 .,, 

It Number pages (or ·N~) is set to 
~rinted" (on page 2) in the abovez:ro, then the first header 
page l . Though setting Numbe xample, would erroneously say 

prevents automatic page n r pages to 0 in the Format menu 
does not prevent a header tr~ri~g at the bottom ot the page it 
backslash is present in the definpirtniting the page number if a 

on line. 

Defining a header (or tooter) whi 
however, prevent automati ch includes a backslash will, 
in the Format menu is set ~op:ge numbers, even though Num~r pages 
now be used to determine ~on-zero number. That value will 
backslash in the header (or fo~t=r)~tarting page number for the 
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To have complete control over the placement of page numbers, you 
can define a header with no text, which will only print page 
numbers. 

For example, the header: 

"Ul N,.100 
·H2 - \ -
will print page numbers (with a hypen on each side) centered at 
the top of each page, 2 lines up from the first line of text. 
Preceding the Header definition, the ·u1 embedded format command 
sets Upper Margin for 1, wh.ich inean.s that the Header will print l 
line down from the top of each page. The "N•lOO" command means 
that the number of the first page will be page 100, and the first 
page number that appears in the first header will be 101. 

F ADDITIONAL HEADER CONTROLS 

There are 4 additional header collllll8Jlds that provide more control: 
·H+ ·a- ·H· -HP. 

·H+: It you put a Plus sign between the H and the number in the 
header definition line, (-8+3 ••••••• -) you will get an 
immediate header. This aieans the header will start on the very 
first page instead of waiting til the second. You might use 
this if you are printing a document in sections, where the 
first printed page is not necessarily the first page of a 
chapter or the document itself . You can also use this form if 
a blank line or line of text between the header detini tion and 
the top of text causes the header to start a page later than 
you want. 

"H-: This coUllllaJld simply shuts otf the Header. It can be placed 
anywhere in the text (on an embedded command line only, ot 
course). As soon as it occurs in the text, all subsequent 
pages will not have headers printed at the top. Unlike the 
normal ·H.co11111181\d or the ·H+ command, the -9- command does not 
have a number or text following it, and it should not have a 
C~et symbol at the end. 

-H~: This works exactly like -H- to turn headers off, except that 
it also turns automatic page numbering back on. This is 
necessary to get automatic page numbering at the bottom ot each 
page once header page numbering has been used in the document. 
(As soon as a backslash appears in a header (or footer} 
definition, automatic page numbering is shut off. And the ·H= 
command is the only way to turn it back on) 

-HP: This disables headers for a single page. It works exactly 
like -H-, but, after 1 page, the Header starts printing again. 
!t is useful, for example, in preventing headers from printing 
at the top of a page that starts a new chapter. 
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Footers work a lot Jik h 
Jin i e eaders In fa t if es g ven as examples above · c • . you talce the Header 
former header lines would now' and changed ff to "F, then the 
footers) instead of at th print at the bottom of each 

e top of each page. page (as 

The Footer definition lin 
and a backslash placed i~eamusft etnd 
current pa oo er 

ge number to print in the 

as well as be i g n with a caret 
f
definition, will cause th~ 
ooter. 

There are only 2 main diff 
you d erences between h d nee to be aware of Fi ea ers and footers that 
does not need to be at th rst, the line that defines the F t 
needs t e exact top of text oo er 

o come somewhere before t · In fact, it just 
you should probably put it h: end of the first page. (Th h 
keep it out of the way.) around the top of your text justou~o 

Second, the number immediat 
lines up from the bottom o~l~hfollowing the F, indicates how man 
footer definition line of "Pl e ~ge, the footer will be. Thus ~ 
~he very bottom line of~···· will position the footer on 
F2 would position it l line uppafge (just before the perforation) 

rom that. · 
Note that this is not 
positioned. Because of thisy!Dmetrical with the way Headers are 
menu) JllUst be large s, the Bottom margin (set in the F 
ex 1 enough to ac d ormat 

a.mp e, the footer is defined wi co~ ate the footer. If, for 
must be 3 or greater for the f tth an F3, then Bottom margin 

oo er to print. 

:f a plus follows the F in the 
F+l ..•......... -), you'll footer definition line (e 

exactly like an illllllediate h ~et an immediate footer. This wo·~ 
printed at the bottom ote~ er -- it'll cause a footer to r 
for the second page. he very first page instead of Walti~ 

The ·p_ and ·p~ and ·pp foot 
Header counterparts. er COllU!lands work exactly like their 

Note that while Multi-line headers 
(see the end of section K bel ) 
same way will not work pr~perl~ , 

ff EMBEDDED CONTROL CODES 

are i;xissible in Telewriter-12a 
multi-line footers done the 

Many printers have the abilit 
boldface, underline, do superscriyts to change type style, print 
features, the printer must be se p , and so on. To access these 
control codes vary f ... o- . nt special "control codes" Th 

d d - '" printer to pr · t · ese 
an escribed in your printer manual.in er, and should be listed 
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Telewri ter' s "Embedd.ed 
any sequence of control 
printing. There are 
the definition line and 

control code" feature allows you to send 
codes to any printer, at any time during 
two parts to using embedded control codes: 
the eabedded control character. 

l) The embeded control code definition line begins with a Caret 
("), followed by the letter 0, followed by a nwaber from l to 
9, followed by a space, followed by a sequence of from 1 to 18 
numbers, whose values can range from O to 255. The letter O 
and the one digit number that follows it (1-9) must not be 
separated by a space. 

Here are 2 examples of embedded control code definition lines: 

·01 27 88 
-04 27 36 27 33 27 118 49 27 81 

The first line defines an embedded control character (1) that 
will send the printer control codes 27 and 88. The second line 
defines another control character (4) that will send the 
codes 27 then 36 then 27 then 33, 27, 118, 49, 27 and 81. 

2) The embedded control character is what actually causes the 
control codes in the definition line to be sent to the printer 
(Remember, the definition line only "defines" a sequence of 
control codes.) 

There are 9 different control characters you can use. On 
screen, they appear as the numbers 1 thru 9, in reverse video. 
This reverse video number corresponds to the first number in 
the definition line (the number illllllediately after the O). 

Thus, when the reverse video 1 (0) is encountered in the 
text during printout, it will cause the sequence of control 
codes in definition line 01 to be sent to the printer. 
Whenever a reverse video 4 is encountered, the codes in line 
04 will be sent (i.e. 27, 36, 27, 33, 27, 118, 49, 27, 81). 

The embedded control characters are shown on screen in reverse 
video to distinguish them from the regular numbers which you 
use in writing. To produce them on the screen, you need to 
hold the CTRL key down and hit one of the nine nwaber keys 
(1-9). The reverse video version of that number will appear on 
the screen at the CUrsor position. 

So, go into the Editor if you're not already there, and hit 
CTRL-1. A reverse video 1 (Bl appears. Hit a few more 
CTRL-number combinations (CTRL-3, CTRL-7, etc.) and watch what 
appears on screen. (You may need to turn up the brightness on 
your monitor to read the reverse video characters clearly.) 

Reme~ber that when these reverse video embedded control 
characters are encountered during printout, they will not be 
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printed. Instead, the number of the control character (l-9) 
will tell the program which definition line to look at (Dl-D9) 
to find the control codes it will now send to the printer. 

I EMBEDDED CONTROL CODES: EXAMPLE 

To make this clear, let's look at an example. The Toshiba 321 
printer manual tells us that Wlderlining on that printer is 
started by the codes 27 73, and stopped by the codes 27 7•. So, 
to enable us to Wlderline with this printer, we'll define 2 
embedded control characters with these 2 definition lines. 

"Dl 27 73 
·02 27 7• 

Now, to Wlderline something anywhere in the text, we just put the 
control character D before it, . and the control character S 
after it -- which looks like this on-screen: 

Tb.is is just some random text to illustrate underlining the word 
Ounderl1ne8. And this is some more random text. 

This wo~ld print as follows, on a Toshiba P321: 

This ls just some random text to illustrate underlining the word 
underline. And this 1s some more random text. 

When the text is printing and the control character D is 
encountered, the program looks at the definition line with the 
same number ("Dl) and sends whatever values are on it. In this 
case, 27 and -13 get sent to the printer, and this puts it into 
Wlderline mode, as desired. 

Printer control codes should be described for you in the manual 
accompanying your. printer. It is up to you to be certain that 
you're using the proper codes to achieve the desired effects. 
Sometimes printer manuals give the codes in "Hexadecimal" or 
alphabetic characters. The numbers you use in an embedded control 
code defin~tion line 1n Telewriter must be dec1-l. If your 
manual does not supply decimal values for control codes, use an 
ASCII conversion table that converts to decimal values. 

Each embedded control code definition must be alone · on its own 
line no text, and no other embedded cownands may go on this 
line. As long as this condition is met, the control code 
definition lines can be placed anywhere in the text. Because of 
this, you can redefine any control character (l-9) any number of 
times. The new definition goes into effect only when the 
definition line is encoWltered during printout. Any instance of 
that control character appearing before this point, will use the 
original definition. 
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. ·t all or part of the control code 
As with embedded format lJnes, l on the printer or during View 
definition line actually prints out ( Examples of syntax 

it contains a syntax error. l print) that means bew the D and the contro 
errors· would include : a space. e~::mber higher than 9 for 
character nU111ber 1·D l 27), or_us~n~1al8) 
the control character nwnber ( 02 . 

an 
1 traneous spaces at the You should also avoid hav ng ex 

embedded control code definition line. 

end of 

J STAClCING EMBEDDED CQtoMAND LINES 

If a control character appears in the 
defined by a definition line. it will have 

it is generally good practise 

text before it has been 
no effect. For this 

to define the control 
top of the reason. ill use in a doCUlllent. at the very 

characters you w f th body of the docwnent. 
text, before the start o e 

Since Tab Stop and Header definition lines mu.st ~~ 
11 what you wind up with, there, 

the text as we • ) looking 
call a "stack" (of definition lines ~ 

at the top of 
something we'll 
something li'ke 

this: 

"t 05 10 15 25 
"dl 27 81 
"d2 27 82 
-d3 27 73 
"d• 21 1• 
-d5 27 42 50 
-d6 27 •2 49 
"dp9 94 
·94 Telewriter-128 

EHBEDD~ C(H4ANDS • 
page ,-

-y+2 
"H9 C63 Sl 01 B5 N=l J+ 

_.__ preferably separated froaa tile 
Text starts here or farther ....,...., 
stack by at least 1 blank line. 

rest Of Your document tile fairly neat, 
This keeps the be 1 ing 

Out Of t he way at the very g nn · all this stuff 

and gets 

i comes at the very top and no 
Notice that the tab definition l ne i the stack ~rom the 
blank lines or text lines separate anything n which needs this 
t That includes the header definition line 
op. · ly on page 2. condition in order to start proper 

. 1·M9 C63 Sl Ul B5 N=l J+) is 
An embedded format coauna..~d lJne These values are norma~ly 
included in the stack for convenien~~~m in the text like this, 
set in the Format rnenu, but putting h t ;irglns you used for this 

have to remember w a 1 . means you never as long as this format Jne 
document. When you go to P:~~~~c document will abide by these 
p~ecedcs a..~y text. your oenu settings for the same 
margins and dJsreg~rd the Format 
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parameters. (Of course cmh-dd d t 
ap · ""-' c ormat 

pear anywhere else throughout the t t 
change tli , . ti ex , 

cse in1 al values temporarily or 

command lines can still 
whenever you want to 
permanently.) 

Stacking control cod d !J · j 
llke this. (before eth: H~~~eondlines at the very top ot the 
handy when doing a View Print r(P :c1tn1t1o~ line), Ciln come in 

r1n Prev1ew). 

text 
very 

Normally, when View p . 
in the text, Jt sends l~l~t encounters embedded control characters 
just as it ld e r associated control codes to the screen 

wou send them to the i 
screen doesn't react to thr pr nter. Unfortunately, the 
it :::imply puts a charac:e codes the way the printer does, and 
code. This will usuall e~h on screen that correspands to the· 
justification of text liny .row o!f the line width and 
will also toss in some str~ ;ithdembedded control characters, and 

g an unexpected characters. 

But by stacking all 
text as shown above (berour c~ntrol code definitions at the top of 
by using CTRL-T to i ore t e start of the actual document} and 
the Editor, or V in t~;t;ate the View Print (rather than CTRL:v in 

ormat menu), the problem is avoided. 

CTRL-T works somethi lik 
wh11e CTRL-V starts th~gView ~jParftial Print (~int). That is, 
butte~ the CTRL T nt rom the very beginning of the 

· • - command will beg.in th 
current cursor Posit.ion Th f e View Print at the 
beginning of the lfne ;~e ore, if you set the Cursor at the 
definition, and use CTRL T t ght after the last control code 
e~bedded control code ch~ ~ s;ar(t the print preview, none of the 

ac er~ 1-9) will get defined. 

This means that when the rint 
control character in thept ~review :ncounters an embedded 
and will thus send nothing t~~h it will find no definition for it 
As a result the embe e screen to try to represent it 
distorting effect on the dprdeidt contriol characters will have n~ 

n prev ew. 

Note that this technique will not el . 
that are defined later in th t im1nate any control characters 
a solution to this and e ext. (But see section L below for 
problem.) ' a slightly different approach to the ~hole 

K PRINTABLE CONTROL CODES, FOREIGN SYHBoLS 

Embedded control codes are usually . 
that _get sent to the printer JUst that -- non-printing codes 
When JUSt1ty1ng text, Telewriter t~oe~ontrol a certain function. 
because they normally d 't not count these codes 
line. on put actual print1ng characters on the 

Out embedded control codes 
"p- 1 ntin " d F can also be used to access S""C1aJ 

d
. - . S co cs• . ou..,d o:: ma..~" p-',.. tc-s •o~ h .--

a..'1 m~th bo ' • -·· · · • · t i•1gs li'k • · ~• " . sym ls. In this case. yol: :'1ecd . . e .orc1g:: 
•. 1at a cn:n:·oJ code definition Wlll send to let '!'elewriter know 

or more ~rintable 

61 

characters. The program wil l then be able to count them tor the 
purpose of right justification. 

To do this, simply change the D in the definition line to OP, so a 
typical embedded Nprinting" code definition line now looks 
so=ething like this: 

-op1 9• 

This line defines the embedded control character D to send an 
ASCII 9•, (which prints as a caret on many printers). This form 
worlcs fine if each code in the line is printable. But sometimes a 
line like this might send a number of codes, only one or some 
which actually print. For example, to send a Caret printed in 
boldface, on a Toshiba 321, the definition line would be: 

"01 27 81 P9• 27 82 

Since 27 81 initiates boldface and 27 82 ends bold face, only one 
code on this line actually needs to be counted as a printing 
character (the 94}. By putting the P in front of the code, you 
tell the progr- tbat this ls the only printing code OD the line. 
and that the others should not be COWlted. 

Tbe rule here is ;timply to put a P before every code OD the line 
that will print. (That is the easiest way to remember it, though 
you can actually pl.it the P before any of the codes. Wbat really 
matters is the number of Ps in the line. Thus, You could just as 
well'bave written the above line as: 

·01 P27 81 9• 27 82 

The main rule to remember, in that case, is that you can only use 
one P per individual code number. 

Printing con.trol codes have another interesting application in the 
world of headers. To do a multi-line header, all you need is an 
embedded control code which sends a Carriage Return to the 
printer. The decimal nwaper 13 will do just that, eo, if you want 
to use multi-line headers, start by defining a control character 
to send a decimal 13. A line like: ·01 13 will do the trick. 

(Of course you can use any number from 1-9 after the D, but make 
sure this number is not redefined anywhere else . in the document. 
It must stay in effect at all times for the multi-line header to 
work properly throughout the entire document.) 

Now, simply include the control character 1n the header definition 
line wherever you want the next line of the header to begin. ln 
this example: 

.H3 this is the lst l1neO this is line 2 
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the embedded control character . ~he~ the header is printed so that" w1ll cause a Carriage Return 
ea er definition line • · 11 everything following it on the 

printed headers Th ,bcwl be the second line · e num r of li ~~~ on all the 
this case 3 (.H3) will be nes following the header . 
multi-line header, n~t the first.counted from the last line ~fl~ 
Note that the Carriage Return does 
printing control code 1·001 13 
counted for right justification. ) 

not have to be defined as 
because Carriage Returns a aren't 

L NON PRINTING LINES 

T~ere are times when it's usefu within a document. Since oul to.make brief notes to yourself 
with the rest of the do~n~ don t want these notes printed out 
put non-printing "comment li • !elewriter provides a simple nes -anywhere in the text. way to 

If you place a Caret-T ("T) line will be ignored dur code at the begiIUling of a li ':::""you print the rest !~J:'::t~t (that is, it """'t .::"Pri~~ 
the text except for the ve ocument) . This will work anywhere 

that postition "T i t ry first line of the text butt 
section 40 ~e). s reated as the tab stop definition li~~· cs!: 

The "T od . c e, used as a comment lin line at a time E h e marker, is only good f 
and th - · ac comment line t or one e T must be followed b ·a mus begin with it's own "T, 
- Y space. An example would be. 

T Left Margin 6 Chr • "H6 C63 Sl ' /lin = 63, Spacing= l 

In this example the "T hThappening in the ~mbedded t~~~nt line is used to describe what's 
us, these "comment li " command line directly below 

you what your embedded c~::an~~~ especially useful for tell!~~ 
control code definition lines are desi mean or what your embedded o ng. 

In conjunction with the V 
used to "comment out" ~~= ~~~~t feature, t .he "T code can be 
putting a "T (space) bef rol code definition lines Th 
line ill ore each embedded · us, • w prevent that line f control code definition 
that the control characters willromtg~ng into effect. This means 
encountered during View Print no defined, and, when they're 
Preview with unrecognizeable cha~ac~hey will not distort the Print ers. 

This is simple to and l accomplish since you can rep ace first to change all ·es to - use use Global search 
View print, and' then to h T ·os before you do the 
before you go to do c ange all the "T ·os back to ·os, just 

an actual paper printout . 
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Note that "commenting out" embedded command lines is the only time 
when 2 Carets can legally appear on the same line (other than in 

Header and Footer definitions). 

M FLUSH LEFT LINES 

If a "T command line comes at the very top of the 
tabs. If it comes anywhere else, and the 'T 
space and then text. it is a non-printing comment 

text , it sets 
is followed by a 
line (as just 

described) . 
However, if the ·T is not followed by a space, then the text 
line that follows it ~ be printed, but will not be effected 
by alignment (CTRL-A). That is, this single line (from the "T to 
the CR that ends the line) will not be combined with either the 
preceding line or the subsequent line when you hit CTRL-A to align 
the text, or set a new Chars/Line value. 

In general. if you have more than 1 line you want protected from 
alignment, a pair of non-align codes (";) around them, is the 
recormnended way to go. "T is provided as a quick and dirty way to 
take care of a few lines here and there. 

N PLUSH RIGHT LINES 
The "> code (Caret-greater-than), haS an opposite effect. If you 
begin a line with it, that line will be printed flush right on the 
page (ending at the same right margin as the rest of the docu
ment.). Like "T, this code is only good for one line at a time. 

0 JUSTIFY ON/OPP 
The "J+ and "J- commands are provided to turn right justification 
ON and OFF dynamically, during printout. The "J+ collllllllild turnS it 
ON, "J- turns it OFF. The J command takes no value and can be 
combined on an embedded format line with the other format coamiands 

(M, C, U, B, etc.) · 

P HANGING INDENTS 

Sections 5B and 5C below feature eJ(alllples of the ·use of hanging 
indents. Notice that each numbered line "hangs" a little farther 
out into the left margin than all the other lines 1n its 
paragraph. Put another way, every line in each numbPred paragraph 
is indented. except the first (the one with the nwnber). 

And that is precisely what the "MD comniand does. · It causes all 
subsequent text to be indented except for the very first line 
immediately following it. The nwnber of spaces to indent is 
specified in the value which immediately follows the "MD on its 
own line. /IS usual, there is no space between the MD and this 
number. This com111and should immediately precede the paragraph it 
is to effect and must not be separated from it by a blank line. 
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Once you initiate a hanging indent ll line, will stay indented Wltil ' ah text after the very first 
the normal margin. The embedded ~ot e~ collll!lalld brings it back to 
followed by the same mman that does this is -M
The following example sh~U:~ !~~t followed the initiating .. -MD". 
screen looked like to produ t~eviated version of what the 
below. ce e hanging indents of section 5B 

"MD3 
1) The filename that by a space. tollows Q must be separated from the Q 

"H-3 HD3 

~t t~~~~n used on a given tile is /Tlcr, you 
extension e extension in the "Q line. If the 

"H-3 HD3 

don't 

3) If a "Q line occurs before 
be acted on at that point and 
be "M-3 

the end of the text , it will 
the rest of that file will oot 

.Row back to some normal text. 

th
in each instance after the first, the indent is 

e normal left margin by the "M-3 bro~ght back to 
different from the standard "M . command . The M- command is 
that it changes both th l command (to set left Margin) in 
time by the same amount· ed eft Margin and Chars/Line at the same 
am t · ecreasing the Harnin 1 

oun , and increasing the Chars/Li l • va ue by that ne va ue by that amount. 

The effect of this is to keep the right 
same place on the printed a margin in exactly the 
to the left. (The "MD commanp ge, while the left margin is pulled 
opposite direction, and no~ ~~e~hthe samfe thing, but in the 
it.) ' every irst line that follows 

Similarly, the "M+ command increases the left Margin by (followed immediately by a number) 
decreasing Chars/line by th that value, while simultaneously 

t h 
e same amount The i ht 

pu w ile the left margin is pushed in. · r g margin stays 

In this rnanu l h a ' t e -M- and "M+ commands are 
emphasize section headings -- pulling them out used in pairs to 
the text and into the left Margin. from the body of 

For e.xample, on screen, the heading f like this. or the next section looks 

"M- 3 
5 CHAIN PRINTING 
"H+3 
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The 'H• command followed by a nwnber increases both right and left 
margin by the same amount (thus shifting a chunk of text to the 
right with respect to the rest of the doCUJDCnt) and the "H• 
command pulls the text in on both sides with respect to the 
margins of the rest of the document. 

In a sense, these 4 Margin commands don't accomplish anything you 
couldn't already do with a combination of the ·c and "H commands, 
but the big advantage in using them is that you only need to 
supply the amount of change to the inargin, rather than the 
absolute Margin value and the absolute Chars/line value for each 

change. 
Note that a hanging indent ("MD3) or the "H+, "H-, "H•, and "Ms 
cominands will not work properly inside a non-align block (";), 
because they change the Chars/line value which in turn causes the 
text to be re-aligned. (See section 4A aboVe, for more.) 

5 CHAIN PRINTING 

In a 12BK color Computer 3, there's room in rlJle'll/Ory for about 24 
double spaced typed pages at one t1111e. This will be enough for 
most applications, and, in those cases, the entire text can be 

contained in one file. 

But, for situations where the a.mount of text exceeds the 48K limit 
of the Telewriter text buffer, the Chain Printing feature is 
prov.ided. It allows tor any number of tiles on tape or disk, to 
be printed out, one after the other, in one complete docwaent of 
any length, without user intervention. 

Because of the differences between disk and cassette, chain 
printing is perfomed somewhat differently in the 2 media: So we 
discuss them separately in the next 2 sections. Disk users can 
skip section A, cassette users can skip B. 

A CHAIN PRIN'fDIG: CASSETTE 

To chain print from cassette, the tiles to be printed, must first 
be stored. one after the other, in the proper sequence, on a 
single tape. For illustration, we'll say we have a 60 page paper, 
consisting of 3 files (aboUt 20 pages each) named CHAPTl, CRAPT2 
and CHAPT3. So, on tape. first save CBAP'fl, then, right after it 

on the tape, cHAPT2, followed by CHAPT3. 

To now print this 60 page docwnent straight through, first, rewind 
the tape and Read in CHAPTl. The tape is now positioned right 
before the beginning of the neict !ile in the chain, CHAPT2. 

Go into the Format Menu and hit Q (Queue command). Type the 
nwnber of files remaining in the chain (in this case, 2) into the 
dialogue box and hit ENTER. Set up all print para.111eters as usual, 
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put the cassette recorder 
at the top of the page. on Play and put the printer on-Jjne, and 

Now just hit P. The 
immediately print out. 
recorder will start up 
and printed. 

The printing wjll i k 
page, so you can bre~ ~ up from exactly where it lett off on the 
course, it's more P a document into files at 
do convenient all ar d any point. Of 

cuments jn complete, di oun if you save longer 
Telewriter-l28's chain stinct chapters, but, if printin t you don't, 
losing continuity. g eature will handle them without 

gnce it finishes printing CHAPT 
HAPT3, and print that It will ~h it will read in the next file, 

the Format menu It.h ethn stop, and return control to 
it to print wh . as printed e 2 additional files you told en you set Queue to 2. 

At any point during all this 
BREAK key or you may abort th~ i~~ may abort the printing with the 
se~tion 3F). Both return you c1e:n1read in (see Chapter III 
se; the Queue value back to zero unly to the menu, but you should 
pr nting i111111ediately again. ess you want to do chain 

Be aware that if Queue is set to 
recorder is not on or th a non-zero number and the 
after a print, the prc)grame~~l~e no files left on the tape, that, 
be trying to find the next f11 not return to the menu . It will 
hung up after a print and the ~ on the tape to print . If you get 
turn on the recorder an eue value is, in fact, not 
III, section 3F). d intentionally abort a file (see ~~~~t 

So, basically, follow thi 
OF QUEUE IN THE FORMAT s ~i~r ALWAYS BE SURE THAT THE VALUE 
;,RINTING. This value should ZERO IF YOU ARE NOT CHAIN 
chain printing". Otherwi only be non-zero when 

after printing. se, the system will t you ~ appear o lock up 

B CHAIN PRINTING DISK 

Assume you have an 80 page d 
separate fil ocument to p-int and it t-•-es on disk: · ...... es up 4 
DOC4/TXT. To print these 4 DOCl/TXT, 00C2/TXT, DOC3/TXT, 
to have a simple l line bed files as one document, you only need 
end of each of the fi tem ded command line in the text, at the · rs 3 documents. 

So, in the text, t th 
the line : a e end of the first file, DOCl/TXT, you 

want 
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Similarly, you want the line "Q DOC3/TXT at the end of the DOC2 
file, and you want "Q DOC• /ncr in the text at the end of I?OC3. 

Now, when Telewriter prints a file, if it suddenly encounters an 
embedded command line that begins with "Q, it will stop printing 
and immediately read in the file whose n.ame follows the Q. 

It will then pick up from where it left off on the page, and print 
out the new contents of the text buffer. So, if you Read the file 
DOCl into the text buffer and hit P in the format menu, it'll 
print to the end of the text buffer where it encounters the l ine 
"Q DOC2/TXT. 

That line will cause it to read in and print DOC2. 
reaches the end of DOC2, the "Q DOC3/TXT line at the 
that will cause DOC3 to be read in and printed, and, of 
the "Q line at the end of DOC3, will read in the •th tile 
chain, DOC•/TXT, and print it. 

When It 
end Of 

course, 
in the 

Since DOC• does not have a "Q line at the end, the print stops at 
the end of that file, and the full document has been printed out 
in one shot. The rules for chain printing are su.marized as 
follows: 

l) The filename that follows Q must be separated from the Q by a 
space. 

2) It the ext~nsion used on a given fi l e is /TXT, you don ' t need 
to specify the extension in the "Q line. It the extensi on is 
anything other than /TX:r, you must specify it in the -Q line . 
The drive number need not be specified, but, 1t it's .not, the 
current default drive will be searched tor the file. Including 
the drive number will enable you to chain print one document 
from files stored on different drives. 

3) If a "Q line occurs before the end of 
acted on at that point and the rest 
printed. Instead, the file named in 
immediately read in and printed 

the text, it will be 
of that file will not be 
that "Q line will be 

4 ) The End Of Text Harker must not be on the same line as the "Q 
line. If this happens, you will get a file not found error 
when it tries to get this file from the disk for printing. So, 
even though you generally want the "Q line at the very end of 
the text, make sure it is at least one line above the End of 
Text Marker. 

5) At any point during printi.~g. you may abort the entire process 
by holding down the BREAK key. This will get you back to the 
Format menu, and any more files in the chain will not be 
printed. 
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6) Note that the chain will be broken and the printing stopped if 
the next file in the chain is not found or if an I/O error is 
encountered. 

C CHAIN PRINTING ~ DISK & CASSETTE 

There are a few things to be a little wary of when chain printing 
on either disk or cassette. 

1) When you are saving files that will be chain printed, you can 
actually break them anywhere and they will print cleanly, but 
it is strongly reco111111ended that you end and begin files (for 
chain printing) at paragraph boundaries. 

.This is really important only if you are right justifying the 
text. Telewriter-128 will not justify the last line in the 
text buffer. This means that, if the next file simply began 
with the next line in the same paragraph. then, on printout, 
you'd have a paragraph with an unjustified line in the middle. 

2) If you are using headers, the header definition line must 
appear at the ~op of each file in the chain, and it must appear 
at the top of the first file printed. After the first file, 
all header definitions in the chain lllUSt use immediate headers 
(·B+) unless you explicitly don't want a header printed on the 
first page of this file. 

3) All embedded control codes used must be re-defined at the top 
of each file in' the chain. Otherwise, the embedded control 
characters won ' t be defined in that file, and if used there, 
they will not work when that file is printed. 
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and fine 
allOWS you to customize d our 

The Telewriter-128 Opt~o~~e~~~ain to suit your hardwa~:n~on~rol 
tune many aspects o With the Options menu, yo~at rates, the 
personal preferences. n and character color, keyfrepbedded control 
things like the scree even the appearance o em 

1 

2 

number of lines on screen, 
characters. You can also 

hit O in the Main Menu. Fl in the 
t the Options Menu, l by hitting Shift-

To get o tions menu instant y 
get to the Oph Main or Format menu. 
Editor or in t e 

CHARACTER COLOR the color of the 
will change ber 

in the Options menu haracter color Nwn 
Hitting C 'by adding 1 to the C it cycles back 
characters on scrh~~n it When the value gets to ~3, Character color 
each time you . will also increase t e b one. 
t 0. Hitting the Up Arrow ow will decrease the nu.rnber y . 
n~ber 'by 1 . Hitting oown Arr 

3 

BACKGROUND COLOR the screen by adding 1 
the Background color of hit it. When it gets 

Hitting B changes color number each time you ress. Hitting Left 

~~ ~~e ~c~fi~~~art back at t~ 0~~~~r~:~ ~~~r nwnber by l · The 
, ill also increase e 

Arrow w ill decrease it by 1. 
Right Arrow key w d to experiment 

the Character color comman up with the 
Use this command and display until you come 
with the colors of the screen 
combination you like. 

You will only chrome monitor, 
If you are using a Mono changes are, of course, 

see a change 
not in color, 

16 nwnbers. These 
every f green or amber. 
but, in shades o 

MONOCHROME nochrome monitor 
N if you're using a mo h colo~ 

Set Monochro~e to 0 ·ust want to get rid of t e -
and white TV. or if you J 
color monitor or TV-

10 

or black 
on your 
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Each time you hit M . will switch to its in the Options Menu, the value 
hitting H will set opposite. If Monochrome Is set 

!t to OFF, and vice versa: 

LINES ON SCREEN 

OPTIONS H£HU 

of Monochrome 
to ON, then 

You have a choice of havin a 24 A 28-line screen will sh~ • 25, or 28 line screen display. 
24 line screen but some yiou 17~ more text at one glance than a 

Th 
. • mon tors may not be bl e 25-line screen di 1 • a e to handle it 

which, for some, might g~~;a~ c~~ov1dedsi more space between lines. arer splay. • 

Each time you hit L in the Options menu 
Screen will cycle through the values 24, 25,· the value of Lines on 28. 

FIND IGNORES CASE 

When the Find command (CTRL string in the text, there ~! !nwath: Editor) tries to find a given 
sure that uppercase letters mat .~ it can look. One is to make 
lowercase matches only l c only uppercase characters and 
"case-sensitive" (being se::~~~::et This is called being 
c~e or lower case). o whether a character is. upper 

The other ..,,,.., i t i ··-1 • s o gnore case Th i " set to ON, the search string "t~" us, f Find Ignores case" is 
etc., and the string "TIME" will will match: time, Time, TIME, match the same set of "time" 
If "~ s. 

"ind Ignores Case"' is t only match "time" d se to OFF, then the word "time" will 
in this mode, 
sentence. 

an not "Time" T 
Find would miss any instance of "time~rth;~beg=~ 
~~tt~eneral, you should leave "Find 
If it?~ ~N~hthe Options menu, sets this 

en you hit F, it changes to 

Ignores Case" set to ON. 
value to its opposite. 
OFF, and vice versa. 

Setting "Find Ignores Case" to 0 replace to capitalize th t• N, also causes Global search and 
it's capitalized in the str~ng_rst letter in the replace string if 
means if you're replacin ci:rrently being replaced. That 
the word "tide" and you hitg :11 _nstances of the word "time" with 
sentence, then it will a:. ~nstance where "Time" begins a 
capitalization of the fi t l replaced with "Tide". The rs etter is maintained. 

AUTO FILE BACKUP (DISK ONLY) 

!n, the course o! working on it s a good precaution to save one file for a long period of time 
after every significant change it to disk every few minutes • or addition. • or 

~i-Flurther safeguard is to maintain - e as a "baclc:u " ., the last saved version of a 
w 1 f P • eac .. t i r.ie you save the c ay, • the current file on disk urrent version. This sor.:ehow gets corrupted 0~ 
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destroyed, you can turn to the backup version which will lack only 

the very last update. 
znenu, a baclc:Up 
a given file 
set to OFF, no 

menu switches 

If Auto F!le Backup is set to ON in the Options 
file will automatically be inade, everytime you save 
to d!sk (after the very first save). If it's 
backup tile will be inade. Hitting A in the Options 
Auto file backup between the 2 states, ON and OFF . 

If you have a lot of disk space, or you ' re working on sinall files, 
you might want to leave Auto File Backup ON most of the time, just 
to have the automatic protection. However, o.~ce you start running 
out of disk space, the backup file starts to get in the way. At 
this point, simply delete it and set Auto File Backup to OFF. 

The name of the backup file on disk is always TW*BACK.TXT and it 
always contains the previous version of the fi l e you've just saved 
(if Auto File Backup was set to ON when you saved it and if the 

file already existed on disk). 

Here is how the backup worlts. Say you are saving a file called 
STORY3 . If Auto backup is ON, the program will first look for a 
file called STORY3 on disk. If it tindS one. it deletes any tile 
on disk called TW*BACK/TXT and renames STORY3 to be TW*BACK/TXT. 
Then it saves the· new STORY3. So TW•BACK is really just STORY3, 

the last time you saved it. 

If it doesn't find STORY3, it will still delete TW*BACK. if such a 
tile exists, and then save your current text buffer as STORY3. 
Thus, when you look at the disk, there will be no backup coP'f at 
all, because th.is is the first time you saved sTORY3 to that disk. 

7 VPRINT DELAY 
If you hold the SHIFT key down during a Print preview, the 
scrolling speed of the text will slow considerably. Vprint delay 
in the Options menu determines what this slower speed will be. 

To set Vprint delay, hit V and type the desired value into the 
dialogue box. The higher the nU111ber, the slower the text prints 
to the screen. The lower it is, the faster it prints. Remember 
that this is not the rate of the print preview itself, but the 
slower rate caused by holding the Shift key down. 

8 REDESIGN CONTROL CHARACTERS: FOREIGN AND MATH SYMBOLS 

Hitting R in the Options Menu, brings up a whole new menu (a 
"sub-menu"). This menu allows you to specify what each embedded 
control character will look like on screen. Instead of the 
reverse video numbers l-9, normally used, the control character 
can be made into any character (including math and foreign 
symbols) that the Color computer 3 can display. 
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As an example of how you'd use this feat 1 ' 
to.use the word cllche in your docw:ient ~:· th:t s assume you want 
print the e c~aracter. (Some ri . t your printer can 
others, not. Consult your printerpm.;~e~stw1ll be able to do this, 
in this regard). a 0 see what yours can do 

In dorder to print a special character like e nee to be sent a co t 1 od • the printer will 
Toshib 32 S n ro c e representing that character. The 

a 1 L, for example, will print an L (decimal) 187 c if you send it a 
· To do that, you simply d 

embedded control code: ef .1ne a "pr in ting" 

·op1 187 

and then, whenever you want to 
CTRL-1. This, of course gives use l! in the text, just hit 
that the word that will.print you a reverse video l on screen so 
appear on screen as "clichO" 0~ paper as "cliche", will actually 
would be i · .t gets the job done, but it 

n ce to see it on screen exactly as it'll 1r. pr .t. 

And that's where the "Redesign" sub to make the D look like an e-menu comes in. It allows you 
Options Menu and hit R to get the "R: ~creen. So, go into the 
sub-lllenu. You'll see a 3-column di es gn control characters" 
the actual control character numbe- sp:ay. The first column gives 
exactly how that control ch - (1 9), the second column shows 
the 3rd column is the ASCII ar~cterfwill appear on the screen, and 

va ue o the on-screen character. 

By changing the value in the on s 3rd column, you can ch 
- creen appearance of the control h ange the 

appears in the 1st column. c aracter whose number (1-9) • 

So let's change the defined by ·op1 ahppei ha.ranee of the 1st control code (the 
• w c normally appe 

prompt at the bottom of th a.rs on screen as 0). 

l 
e screen asks "w.tich cont 1 d 

• now, to change the lst control characte~. . ro co e". 

one 
The 
Ra 

When you do this, a new prom t value for CTRL-1" T P appears, asking you for the "New 
the ASCII hi-res ~extos~~!e~het~~~er you need here, first consult 
Computer 3 lllClnual. This table s~~sthe back of the Color 
special characters that the Col C you all the normal and 
and •t l or ompute- can displa 

l te ls you the number that will di · Y on screen, splay this character. 

The table lists the e charact d 
generate it is 130 Fo- the e~ ~ says that the ASCII code to 
greater than 128 .. you ~eed t~pe.c b~ characters with ASCII values 
the "Redesign" menu wants S·bsu ract 128 to get the nwnbe:r that 

. a tracting 128 from 130 leaves 2 . 

~~::~~Lo!~ a~ t~enr 2nedsponsle to the "New value ... " prompt, and 
· · co umn of row 1 d , 

reverse video 1 for~e-ly th~ h ·;an you ll see that 
Editor and hit C~RL-' ·.;.de. :re, as c.a~ged toe. Return to 

-· - · appears on-screen at the CU.:-sor. 
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Remember now. that this e is still really the control character 
D in disguise, and that, when encountered during printout, it 
still looks at the ·01 definition line to see what code it must 
send. So from here on. you just type: "clich" CTRL·l, and you'll 
see the word "clichl!" on screen as well as in your printed 

document. 

When you're all done working in this sub-menu, hit the red 
BRE.AK/ESC key to return to the Options Menu, or hit Fl or ~ to 
return to the Editor, or F2 to go to the Main Menu. 

~1tt1ng K in the Options menu will bring up the Key-rate 
sub-menu. There are 7 settings in this menu, 6 of which deal with 
the keyboard Auto repeat speed and delay. 

For the purposes of these settings, the keys are considered in 2 
groups: l) The alphabetic keys, including numbers, symbols and the 
SPACEBAR. and 2) The 4 cursor keys plus the BREAK (delete) and 

CTRL-BREAK (back-delete) keys. 

There are 2 numbers to set for each group: the key repeat delay 
and the key repeat speed. The delay determine• how long the key 
has to be held doWn before it begins to repeat, and the repeat 

speed deterimines hoW fast the keys will repeat. 

The.lower the repeat speed number. the faster the keys repeat when 
held down. with o (zero) being the fastest speed. The larger the 
delay number, the longer you have to hold the key down before it 
repeats. If, however, the delay is set to O, then the keys in 

that group will not repeat at all. 

Since Telewriter-128 features a dual-speed cursor, there are 2 
pairs of speed and delay values for the cursor and delete keys: 
one pair for the key alone, another pair for a cursor (or delete) 
key 2lus the SHIFT keY· Telewriter is initially set so that 
holding down the SHIFT key provides a faster repeat speed and a 
shorter delay th.an the un-SHIPTed cursor/B."lEAK keys. Though, the 
Key rate menu allows you to set these to whatever you want, 
generally the SHIPTed keys should be the faster ones. 

Setting values in the Key-rate i=enu works 
other menus: numbers, not letters. are 

differently from the 
used to specify the 

par~eter to be set. 

so go to the Key-rate menu and hit l. A dialogue box will appear 
with the current key repeat delay for the "alpha"(betic) keys. To 
change the value, type in the new nlllllbe:r and hit E.'f!ER. When 
you're returned to the Key-rate menu, hit 2 and type in the repeat 
speed for the "alpha" \ceys. You can set the other Delay and 

repeat Speeds in the same fashion. 
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These numbers 
with them as are mainly a matter of personal taste Experiment 
prefer. you use the program. until you find the ones you 

~~eca~;~~~o~ to set delay values too low for the 
.e cursor/delete keys Thi alpha keys or 

characters or Wlexpected deletions i s can result in extra 
delete key is held down a split ndthe text if an alphabetic or 
to hit it once. secon too long When you only want 

The 7th value you can set in the 
If you have the keyclick feature ~:;nrate menu is "Keyclick tone" 
adjust this value to provide a ed on, you might want to 
you hit a key. Simply hit 7 inm~~e :udible or pleasing sound when 
new value. Then hit some k e ey-rate 111enu and type in a 
Experiment with different value e~~l and see what it sounds like. 

s you get what you want. 
10 SAVE/INSTALL! OPTIONS FILE 

The Options File saves ALL 
and Format the values you've set in the Options 

menus as well as all the Macros you 've 
Chapter 7, below), so you don't h defined (see 
rwr T l ave to reset them . e ewriter. Though they accomplish the every time you 
systems, the disk and cassett Op i same ends in both 
differently. Section A bel e t ons files are handled 
users, and section B de~;i~:cribes the operation for Disk 
Cassette users should still d the Cassette Options file. 
file, in order to understandr1~ basectiion A on the Disk Option 

s s c functioning. 

A DISK OPTIONS FILE 

Each time you run T 1 automatically loaded and e ewriter-128, the Options File is 
and Opttons menus and to usetd to set all the values in the Format 

se up pre-defined Macros. 

Any time you rnake change t th 
(or to the Macros) ans do e Options or Format Menu settings 

· you'd like to k h 
permanently, go into the Options M eep t ese changes 
to disk" COll'.mand). When the di l enu and hit S (the "Save Options 
drive number, hit 0,1,2,or. 3 da ogue box appears asking you for a 
the Options file to go to. • ependL~g on which drive you want 

hit Then, when you 
settings and 
'!W•DEFS.BIN. 

ENTER, all current Options, 
cMac:os will be Saved to disk in 
.revious settings will be overwritten. 

Fonnat menu 
a file called 

The next time you run Telewriter-128 
settings you have now will b i from this disk, all the 
the program comes ~p. Thee s tting there waiting for you when 
. settings have bee t 
installed from that rw•oE~S.S!N file. n au omatically 
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If you run Telewriter from another disk which gives you different 
settings, a.~d you want these. simply place this disk in any drive 
and hit . I in the Options menu. The "Install Options" command will 
go to the drive you specify in its dialogue box, find the 
TW*DEFS.BIN file there, and Install all the settings and Macros it 
contains. All current settings will be replaced by these new 
ones. 

Most people, after an initial period of experimentation with 
different settings. will eventually find one set they prefer, then 
put this on their Telewriter-128 program disk, and rarely bother 
with the Options menu or the Options file again. 

Other people may choose to keep separate program disks. each with 
a different Options file for different circumstances. One disk 
might have Format settings and Macros for personal letters, 
another might have different Format settings and Macros, for 
writing papers. Still another disk might have Options Menu screen 
settings tor an RGB monitor. while another might have settings for 
a Monochrome monitor. 

You can also use the Change filename co111111and in the Hain menu to 
change the name of the '!W•OEFS.BIN file to some descriptive naJ!le 
and keep a number of them on one disk. .Just remember, that in 
order to Install o:ie (or have it automatically installed a t run 
time) it must be renamed back to '!W•DEFS . BIN. 

B CASSE'ITE OPTION FILE 

Though the Options file has the same effect in a cassette system, 
the way it is dealt with is a little different. Automatically 
loading the Options file when you initially run Telewriter is :iot 
really viable on cassette. Instead, you must go to an Options 
file you have stored on tape somewhere, and use the Install 
command in the Options me:iu to load it. 

In terms of Saving Options and Installing Options from the Options 
menu, you want to deal wit.~ these cassette Option files pretty 
much the way you deal with regular text files. That is : 

Once you've used Telewriter-128 a bit and you have a set of 
Options, Format settings ar.d Macros that you want to use all the 
time, simply set these up in the progral:I, go to a blank place on a 
data tape, a.~d press the Play and Record buttons on the recorder. 
As soon as you hit S in the Options menu, the tape will start a.'ld 
the Options file will be saved. It you make further c hanges now 
or at a later date, you can Save a new Optio~.s file at a later 
place on the same tape or on a.~other tape. You might want to put 
it on its own tape or just save it o~ a tape with your other text 
files. 

On tape, the Options file is named TW•OEFS. though you don't need 
to know this to Save it or Install it. You ca.~. however, save a 
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number of differnt Options files, with different settings !or 
different writing situations or dif!erent hardware. Since the 
file will always be called TW•DEFS on tape you will need to keep 
some descriptive information in your tape logs as to the nature of 
the Options etc. it contains. 

To Install an Options file, when you first run the program or at 
any time in the midst of using the program, simply put the tape 
with your Options file into the recorder and position it to just a 
little before the start of the Options file. Go into the Options 
Menu a.~d hit I. The tape will start, and will search until it 
finds the the first file named 'IW•DEFS, and then Install it. 

The same procedures are used here in terms of I/0 errors a.~d 
aborting loads, as were described in the sections on Reading in 
a.~d Saving cassette text files (Chapter III, section 3). 
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VII. MACROS 

1 OVERVIEW 

There are certain words and phrases which you use frequently in 
the course ot writing, and it's a shame to have to type them over 
and over again every time. 

Telewriter-128's Macro facility gives you 26 individual key 
commands, each of which can insert upto 127 characters into the 
text with a single keypress. Not only can you store trequently 
used terms or proper names, but also things like multi-line 
headings to use at the top of letters. You can even store whole 
sets of pr~nter control code definitions or frequently used 
embedded format commands. 

2 DEPilfINO MACROS 

To define a Macro, 
(CTRL-semi-colon). 
with a list of the 
prompt to "press 
current macros". 

start in the Telewriter Editor and hit CTRL-; 
The "Macro definition screen" will appear, 

currently defined Macro keys at the top, and a 
key you wish to define or hit ENTER to view 

So let'• s a y you're writing a Telewriter-128 manual and you're 
gonna' be using the word Telewriter-128 a lot. It would be nice 
not to have to type it in everytiD!'., so let's define a Macro to do 
it. 

The macro key can be any alphabetic key fro~ A 
or symbols). So hit T (for Telew:-iter-128) 

to Z (no numbers 
in the Macro 
appears on the 
key, if any, 

definition screen. Immediately, a new prompt 
screen. showing you the current definition of that 
and asking for a new one. 

Sow, simply type in the word or phrase you want that key to 
represent. In this case, type in ''Telewri ter-128", and h! t 
~NTER. The Macro tor T is now set and you're returned to the 
Editor. Cursor to some open space a.~d hit ALT-T (hold down the 
ALT key and h!t T) . The word Telewriter-!28 will instantly write 
out at the Cursor. 
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TELEWRIT,..R-!28 !'IACROS 

~! t C'!'~L-; now , to re t urn ~o the Mac r o Screen , and then hit '!'. 
The " current definit ion" is d isplayed -- i n t h:s ca s e "Tel ew:-ite r-
128" -- and then the prompt to "Enter new de!in ! t i on". Whatever 
you t ype i n now wi!! become the new defi ni tion :o: A~!- '!' , w!pin~ 
out Telewri ter- 128 . Sut, it you want to keep the ALT- T 
combi nation !or Tel ewr!te r-128 , s i mply h!t t he SREA.~ key . You' l! 
be returned c leanly to the Edi tor without effec ting the current 
de!injt i or. o! A!.!-T . Note. however, that h i tt i ng ENTER at t his 
po i nt would also return you to the !ditor. ~ut the curren t 
de f i:~!tion o! ALT- '!' wou l d be replaced with nothing . 

3 SPECIAL CHARACTERS IN MACRO DEPINITIOMS 

A powerfu! feature of Telewriter-128 Macros is their ab1l~ty to 
include many of Telewr iter's spec ial characte rs. The Caret( - ), 
all the embedded control characters (CTRL-1 CTRL- 9), and the 
Carriage Return charac ter (norr.ially i nvi sible) can all be included 
in a Macr o defini tion. 

When you want the CR character t o appear in a Macro def1r.ition , 
h it CTRL- ENTE.R. A r everse video Left A:-row will appear , 
repres enting the Carriage Return character. Though t his Macro rnay 
be only a s ingle line in the Macr o definition screen, when it's 
actually invoked in the Editor with the proper ALT-key 
combinat ion, t he Carr iage Return will cause it to print on screen 
(and in t he text ) as 2 lines . Thus , a Macro c an generate many 
lines of t ext on the screen , even t hough i ts definition is ju.st a 
line or t wo l ong . This is useful , fo r example, for 3 or 4 line 
l etter headings . 

To put the Caret character in a Macro definition, simply hit 
CTRL-. (CTRL- period ) . This will appear as a Caret (") in the 
Mac ro definition , exac tly as it does in the Editor. This allows 
you to inser t whole sets of Control character de!inition lines or 
Embedded torniat collll!laJlds with a single Macro key . For example, a 
single keypress could instantly insert the following sequence of 
control code definitons a t the top of your t e xt, whenever you 
start a new document. 

"t toshiba codes 
-d l 27 81 
"d2 27 82 
"d3 27 73 
- d 4 27 74 
"d 5 27 42 2 
"d6 27 42 0 
"d7 27 18 
"d8 27 20 
· dp9 94 
"H9 C63 Sl Ul 85 

To ce! !ne a ~ac~o to do this. you 
de ! !n!:!on sc reen ar.c type it in exact!y 
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s !~p!y ~o !nto t he ~aero 
as you wou! d in t he 

l".ACRr 

Editor -- the only difference is that where you would normally h i 
ENTER to go to a new line, hit CTR!.-ENTER to put the Carria~ 
Return character into the Macro line. When you execute the Haer 
in the Editor, the carriage Return character will give you t i 
separate lines you want, as shown in the example above. 

Similarly, to put any or all of the 9 embedded control characte: 
in the Macro definiton, just hit the normal Editor key combinatit 
t or that character (CTRL-1, CTRL-2, etc.) . The character wi ! 
appear in the Macro' definition line exactly as it does on screen . 

4 SAVING THE DEFIKITIONS 

In a short amount of t ime, you can develop a large set of Macro~ 
and you certainly don't want to type them in every time you r u 
Telewriter. so, like the Options and Format menu settings. a l 
the Macros you define are saved 1n the Options file (TW*DEFS.Bil'
everytime you "Save Options to Disk (or cassette)" from tr 
Options menu. 

So, whenever you define a new Macro that you want to keep arour 
for next time, go to the Options menu and hit S, and .save t h 
Options file to disk (or cassette) . Similarly, make sure you boc 
up with or Install this Options file when you want to use t h <.. 
particular set of Macros. 

5 VIEWING AND EDITING CURRENT MACROS 

Everytime you hit CTRL-; and go to the Macro definiti on scree1. 
the top line tells you which keys have already been defined. 1 
see what these definitions are, hit the ENTER key . . The lin 
"CUrrent macro definitions" will appear, and, below that, t h 
def inition for the (alphabetically) first Macro key that's bee 
previously defined . 

Hit ENTER again, and the (alphabetically) next Macro will l 
written out on the next few lines. Keep hitting ENTER and it wiJ 
display each key and its associated Macro definition , ! 
a l phabetic sequence. 

To stop viewing these at any point. just hit the BREAK key, ar 
you will be returned to the first prompt, asking you to give a k~ 
to be defined. At this point, either hit a key from A- Z to defir 
a new one , or h i t B~ to get back to the Editor. Hitting ENT~ 
here wil! start listing the Macro def initions all over again. 

Of course , yo~ ca.~ v i ew t he def i n i tion o ! 
j us t h i tt i ng t hat key when the prompt as ks 

a.~ indi vi dual key 
f or a key to define. 



You can edit the Macro line as you type it in, by using the Left 
Arrow key to delete the last character and back up the Cursor. If 
you have a change to make in a short Macro, it's usually no big 
deal to type all or p~t of it over again. 

However, if you have a long or complex macro, and need to make a 
cha.~ge in it, you can actually use the Telewriter Editor to do 
this. Let's use a simple example to stand for the complex 
example: changing the ALT-T Macro definition from Telewriter-128 
to Telewriter-1024, without retyping. 

First, go into the Editor, to a blank line. and hit ALT-T. Of 
course it writes out "Telewriter-128". Use the Editor, now, to 
change this to Telewriter-102•, then surround the new word with 
Begin and End markers, just as you would for a block Copy. 

Now hit CTRL-; to go into the Macro definition screen. Hit T to 
define the T key, and the current definition: "TeltMriter-128" 
will be written out, followed by the prompt asking for a new 
definition. ,.ow, simply hit CTRL-C, exactly as you would in the 
Editor to do a block Copy. "Telewriter-102•" will be written into 
the Macro definition, and, if you now hit ENTER, that becomes the 
new definition. 

Of course, it'll take a much longer and more complex definition 
(like the sequence of printer control lines shown above) to really 
illustrate the value of this capability. 

Note that block Copying Embedded control characters and invisible 
CRs from the Telewriter Editor into Macro definitions, will work 
exactly as it you'd typed them into the Macro definition line. 
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